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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

A wArRNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A caution
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger
will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating
to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the
specific task in accordance with the relevant documentation, in particular its warning notices and safety
instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying
risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

A wWArRNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens Aktiengesellschaft. The remaining trademarks
in this publication may be trademarks whose use by third parties for their own purposes could violate the rights
of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency.

However, the information in this publication is reviewed regularly and any necessary corrections are included
in subsequent editions.
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STEP 7 CFC Readme

1.1 Cybersecurity information
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Siemens provides products and solutions with industrial cybersecurity functions that
support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats,

it is necessary to implement — and continuously maintain — a holistic, state-of-the-art
industrial cybersecurity concept. Siemens’ products and solutions constitute one
element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines and networks. Such systems, machines and components should only be connected
to an enterprise network or the internet if and to the extent such a connection is necessary
and only when appropriate security measures (e.g. firewalls and/or network segmentation)
are in place.

For additional information on industrial cybersecurity measures that may be implemented,
please visit
https://lwww.siemens.com/global/en/products/automation/topic-areas/industrial-
cybersecurity.html

Siemens’ products and solutions undergo continuous development to make them more
secure. Siemens strongly recommends that product updates are applied as soon as they
are available and that the latest product versions are used. Use of product versions that
are no longer supported, and failure to apply the latest updates may increase customer’s
exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Cybersecurity
RSS Feed under
https://new.siemens.com/qglobal/en/products/services/cert.html,
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1.2 Scope of delivery for SIMATIC STEP 7 CFC

1.2 Scope of delivery for SIMATIC STEP 7 CFC

The scope of delivery includes:
* SIMATIC STEP 7 CFC V19

Configuring CFC charts
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1.3 What's new in SIMATIC STEP 7 CFC in TIA Portal V19?

1.3 What's new in SIMATIC STEP 7 CFC in TIA Portal V19?

Stability and performance

With SIMATIC STEP 7 CFC V19, further improvements have been made to the stability
and performance.

Overview of important performance improvements:
¢ Configuring of CFC charts

e Editing of CFC charts in groups

e Compiling and downloading of CFC charts

e Opening of CFC charts in runtime

CFC tag interconnections

The new list of CFC tag interconnections in the "Chart sequence & extras" editor
supports you in searching for interconnected operands.

As in the cross-reference list, you can filter and sort the list of interconnected tags and
global data blocks.

TIA Portal Openness: Exporting and importing CFC charts

Stability and performance when exporting and importing CFC charts have been improved.

Changed icon: Add input parameters

In the "Data flow" tab of the CFC editor, you can add additional input parameters
at a block instance with a mouse click.

The icon for this has been adapted to be consistent with the representation in other editors
of the TIA Portal:

e lconuptoCFCV18: &
¢ New icon as of CFCV19:

Configuring CFC charts
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1.3 What's new in SIMATIC STEP 7 CFC in TIA Portal V19?

CFC editor: Additional functions
Screen resolution:
¢ Support for high-resolution screen settings
Zoom function in the data flow:

¢ When you zoom in on the view, the input boxes for editing interconnection paths
are also zoomed in on.

The font size remains the same, so that the boxes provide more space for editing
long interconnection paths.

Highlighting of interconnections:

¢ The color highlighting of connected and unconnected interconnections has been
optimized.

Sheet bar view:

* To adapt the width of fixed sheet bars to the text length of the interconnections,
double-click the boundary line of the sheet bar.

Opening a CFC chart:

* When you close a CFC chart after editing and then reopen it, the preceding settings,
e.g. zoom factor and position of scroll bar, are applied.

See also
Basics of CFC (Page 25)
Export/Import of CFC charts (Page|373)
General information about SIMATIC STEP 7 CFC (Page|17)
Notes on exporting/importing CFC charts (TIA Portal Openness) (Page 23)
CFC charts for S7 target systems (Page|235)

Displaying points of use of interconnections (Page|153)

Configuring CFC charts
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1.4 System requirements for SIMATIC STEP 7 CFC

1.4 System requirements for SIMATIC STEP 7 CFC

Hardware requirements

¢ Requirements of TIA Portal V19

Software requirements
e TIA Portal V19

Supported systems
CFCin the TIA Portal supports CPUs of the following product groups.
Requirement:

¢ Firmware version = V2.8

Advanced Controllers

e Standard CPUs

¢ Technology CPUs

* Fail-safe CPUs V)

 Fail-safe technology CPUs "

* Redundant CPUs 2

1) Only with deactivated fail-safe functionality.

2) In the compatibility tool you find detailed information on which CPUs are supported.

Distributed Controllers
e ET 200SP CPUs
e Fail-safe ET 200SP CPUs "

1) Only with deactivated fail-safe functionality.

Software Controllers
e Standard CPUs:

- CPU 1507S

— CPU 1508S

Restrictions
e STEP 7 Safety and F-CPUs with enabled F-function are not supported.

You can use either CFC or the fail-safe functionality on a CPU.

Configuring CFC charts
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1.4 System requirements for SIMATIC STEP 7 CFC

Compatibility tool

With the compatibility tool, Industry Online Support gives you a function you can use to
put together a compatible selection of software products or to check existing configurations
for compatibility.

In the following entry you can call the compatibility tool and find additional information
on the operation of the tool:

¢ Internet: "Compatibility Tool for Automation and Drive Technology” (entry ID: 64847781)
(https://support.industry.siemens.com/cs/ww/en/view/64847781)

See also
CFC charts for S7 target systems (Page|235)

Configuring CFC charts
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1.5 SIMATIC STEP 7 CFC licensing

1.5 SIMATIC STEP 7 CFC licensing

License types

Configuring CFC charts

For CFC, you need an engineering license as well as runtime licenses for each CPU.

Engineering license

A license key must be installed on the PC to configure CFC charts.

Runtime licenses
You need a license key for each PLC.

Depending on the number of instance data blocks which are created during configuration
with CFC, you either need a limited or unlimited license:

¢ Alimited license allows you to create a limited number of instance DBs and load them
to the PLC.

e With an unlimited license, you can create and upload an unlimited number of
instance DBs.

You can find information on the instance DBs in the "Chart sequence and extras" editor
in the "Statistics" tab. The number of instance DBs is displayed which have been created
in all CFC charts under the PLC.

More information in the TIA Portal Information System:

¢ "Configuring technologically > Configuring CFC charts > Working with CFC charts for S7 >
"Chart sequence & extras" editor for S7 (Page 242)"

Trial license

If you do not have a valid license, the system alerts you that you are working
in a non-licensed mode.

You have the one-time option of activating a Trial License.

However, this Trial License is valid for a limited period only and expires after 21 days.

System Manual, 11/2023, A5E53466205-AA 15
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1.5 SIMATIC STEP 7 CFC licensing

Licenses for SIMATIC STEP 7 CFC V19.0

License Display in the Comment
Automation
Licence Manager
SIMATIC STEP 7 CFCV19.0 SIMATIC STEP 7 CFC Trial license
Software Media Package Advanced 19.0 The license is already included in
the TIA Portal installation.
SIMATIC STEP 7 CFC 19.0 Advanced | SIMATIC STEP 7 CFC Engineering license
Engineering Advanced 19.0
SIMATIC STEP 7 CFC Runtime CPU | - Runtime license:
(limited)

¢ Unlimited runtime
e Limited number of instance DBs

SIMATIC STEP 7 CFC Runtime CPU - Runtime license:
(unlimited)

¢ Unlimited runtime

¢ Unlimited number of instance
DBs

More information

See also

16

Online catalog (Industry Mall)

e Internet: "STEP 7 (TIA Portal) options: STEP 7 CFC (TIA Portal)"
(https://mall.industry.siemens.com/mall/en/WW/Catalog/Products/10414342?tree=Catalog
Tree)

TIA Portal Information System

* ‘Installation > Licensing"

Automation License Manager (ALM)

To open the manual, in the Windows program group "Siemens Automation”, select the entry
"Documentation”.

The "Manuals" folder contains the link to the manual in the respective language folder.

CFC charts for S7 target systems (Page|235)

Configuring CFC charts
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1.6 General information about SIMATIC STEP 7 CFC

Content
The information in this Readme file supersedes statements made in other documents.
¢ Important information on product properties
¢ Information that could no longer be included in the online help.

Read the following notes carefully because they include important information for installation
and use.

Read these notes prior to installation.

TIA Portal projects: Restrictions
The following functions are not supported when using CFC in the TIA Portal:
e Software units
Do not create software units on controllers for which CFC charts are configured.

The configuration of software units can lead to the TIA Portal project no longer being
compiled for this controller.

¢ UMAC-protected projects
¢ Downloading blocks generated by CFC from the device
¢ Load CFC charts on memory cards

¢ Interconnect PLC tags with complex data types

Configuring CFC charts
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1.6 General information about SIMATIC STEP 7 CFC

Global data blocks in CFC

To improve performance, create the block structure for global data blocks according to
TIA Portal recommendations.

More information:

¢ Industry Online Support: "How do you efficiently and effectively program for the
S7-1200/S7-1500 in STEP 7 (TIA Portal)?"

(https://support.industry.siemens.com/cs/ww/en/view/67582299)

¢ Industry Online Support: "Programming Guidelines and Programming Styleguide
for SIMATIC S7-1200 and S7-1500"

(https://support.industry.siemens.com/cs/ww/en/view/81318674)

ACAUTION

Avoid changing the structure

When interconnecting global data blocks in CFC, the following constraints apply:
* Avoid subsequent modification of interconnected global data blocks.
* Avoid changing the structure of global data blocks.

Loading after a structure change causes the PLC to stop.

Download of changes during operation is not possible.

Password: No authorization, no know-how protection of the charts

To protect a CFC chart or hierarchical CFC chart from unintentional editing, you can protect
the chart with a password.

NOTICE

Activating password for CFC chart
The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:

* Protection against unauthorized access to know-how in CFC charts
» Security-relevant authorization for access to CFC charts

Instructions: "LBCFC" library for download

The "LBCFC" block library supplements the instruction library installed with SIMATIC STEP 7
CFCV17.

More information:

* Industry Online Support: SIMATIC STEP 7 CFC V17 - "LBCFC" block library (ID 109800972)
(https:/Isupport.industry.siemens.com/cs/ww/en/view/109800972)

Configuring CFC charts
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Instructions: No version update
Always use the current version of the application library.

After the first import of an instruction in CFC you can no longer change the version.
All further instances of the instruction are created with the same version.

When you change an instruction version in the library later, the instruction is marked
as "not supported" with an asterisk.

GRAPH blocks: Using only in a block shell

You cannot insert GRAPH blocks as instances in a CFC chart. Any change of a GRAPH block
would then eliminate the ability to perform an online delta download and would require
a complete download in CPU Stop.

To work with a GRAPH block in CFC, create an organization block (OB) that uses a GRAPH
block.

Even if you change and re-initialize the GRAPH block, you can then update the CPU in runtime
using a delta download.

Using an FB as a call block

If, for example, a GRAPH block affects the CFC run sequence, create a function block (FB)
as a "call block" that calls an instance of the GRAPH block.

If input parameters and output parameters have been configured at the call block,
you can pass these values to the called instance of the GRAPH block.

Ensure that the interface of the GRAPH block is no longer changed. Interface changes
eliminate the ability to perform an online delta download.

Procedure:

1. Create a GRAPH block.

To create an instance of the GRAPH block, create a new data block (DB).
Select the GRAPH block as "Type".

Create a function block (FB) as call block.

In the FB, configure the call of the DB that you have created as the GRAPH instance.

o v ok W N

To exchange values with the called GRAPH instance, configure the corresponding
input parameters and output parameters at the FB.

7. Drag the FB into your CFC chart.

The FB instance in the CFC chart gives you access to the called instance of the
GRAPH block.

Configuring CFC charts
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1.6 General information about SIMATIC STEP 7 CFC

Data types

Data types supported to a limited extent
The following data types of the S7-1500 are supported to a limited extent:
* ARRAY
All data types are permitted for the ARRAY components, except:
— ARRAY
— Reference data types:
Pointer: ANY, POINTER, VARIANT
Parameter types: COUNTER, TIMER
More information in the TIA Portal Information System:
"Configuring CFC charts > Data types in CFC > Compound data types > ARRAY (Page|227)".
* VARIANT
No blocks with output parameters of the VARIANT data type

Unsupported data types
The following data types of the S7-1500 are not supported:
e WString
Exception: The WString data type is used with OPC UA.
e Block FB
e Block FC

Functions with standard access and input parameters of type "ARRAY"

Functions (FC) are not supported in SIMATIC STEP 7 CFC V19 when the following conditions
are met:

¢ No optimized access
* No type-safe addressing
e One or more input parameters are of type "ARRAY".

The non-type-safe programming of FCs with standard access that have input parameters
of type "ARRAY" will be supported again in the next version of SIMATIC STEP 7 CFC.
If necessary, install the CFC V19 updates.

Type-safe data block with elements of type "ARRAY": Do not change access mode

Avoid changing the access mode to standard access for type-safe data blocks with
optimized access that are linked to a function (FC) via the "ARRAY" data type.

If necessary, create a new, non-type-safe block without optimized access and relink
the parameters.

Configuring CFC charts
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Do not change internal CFC blocks

CFC creates system blocks that are displayed in a number of views or lists, for example,
under "Program information".

You may not change these objects.

Only edit your own blocks and instructions using the STEP 7 editors.

Redundant CPUs: Downloading changes

You can only download changes in CFC to the redundant CPU that was also used for the
previous download. The time stamps are compared internally for this purpose.

Take this special feature into account, especially when switching over the redundant partner
and when using the "Download to backup CPU" function.

"Download to backup CPU"

Once you have executed the "Download to backup CPU" function, you can no longer
download the changed CFC data to the primary CPU. After loading the backup CPU,
the primary CPU has an outdated time stamp.

To download CFC changes, switch the roles of the primary CPU and backup CPU.
More information in the TIA Portal information system:

¢ "Editing devices and networks > Configuring devices and networks >
Creating configurations > Configuring automation systems >
Principle of operation of S7-1500R/H CPUs > Loading an S7-1500R/H CPU >
Downloading project data to the backup CPU"

Full compilation: Reinitialization of runtime values

When you perform a full compilation of the CPU, a subsequent delta download may result
in reinitialization of runtime values, e.g. in instances of functions (FCs).

However, the runtime values are retained in instances of function blocks (FBs).

Deleting CFC charts and disabling CFC

When you delete all CFC charts, the option "SIMATIC STEP 7 CFC" remains active in the
TIA Portal.

Downloading to the PLC therefore causes the project to be saved.

To disable CFCin the TIA Portal, delete all CFC components:

1. Select the entry "Charts" in the project tree.

2. Select the "Delete" entry from the shortcut menu and confirm with "OK".
The full contents of the "Charts" folder are deleted.

3. To re-enable the "CFC" option, double-click the entry "Add new chart" under "Charts".

Configuring CFC charts
System Manual, 11/2023, A5E53466205-AA 21



STEP 7 CFC Readme

1.6 General information about SIMATIC STEP 7 CFC

Tooltips in the sheet bar: Avoid overlaps

See also

22

Tooltips may show the complete interconnection path for interconnections in the sheet bar
of the data flow.

These tooltips can impede editing of the interconnection path because they are shown over
the text box.

To avoid this behavior when editing long interconnection paths, increase the zoom factor
for the view of the CFC chart to over 100%.

This also zooms in on the input boxes in the chart and in the sheet bar. At 200%, input boxes
in the sheet bar are enlarged up to the edge of the area.

The text size in the input box is not affected by the zoom factor. The larger input boxes
therefore allow convenient editing of even long interconnection paths.

Disabling tooltips
Alternatively, disable tooltips in the TIA Portal settings:

¢ "General > General settings > Tooltips: Show truncated texts completely"

Notes on exporting/importing CFC charts (TIA Portal Openness) (Page 23)

Configuring CFC charts
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1.7 Notes on exporting/importing CFC charts (TIA Portal Openness)

1.7 Notes on exporting/importing CFC charts (TIA Portal Openness)

Notes on CFC Openness applications

Openness: "filter" parameter

The "filter" parameter is not evaluated during export and import in the current CFC version
and has no function.

Openness: Error message when importing

If the import using the TIA Portal Openness APl is aborted with an error message regarding
the work memory, check the work memory on the PC.

If necessary, increase the work memory according to the hardware requirements for
large projects:

¢ RAM: 32 GB for large projects

See also
General information about SIMATIC STEP 7 CFC (Page|17)
Export/Import of CFC charts (Page 373)

Industry Online Support: "SIMATIC Process Control System PCS 7 Help on data transfer dialog"
(https://support.industry.siemens.com/cs/ww/en/view/109812471)

Configuring CFC charts
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1.7 Notes on exporting/importing CFC charts (TIA Portal Openness)

Configuring CFC charts
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Introduction and basics

2.1 Basics of CFC

What is CFC?

Using CFC

See also

Configuring CFC charts

"CFC" stands for "Continuous Function Chart".

With CFC, you create user programs by simple placement, parameter assignment and
interconnection of instructions and blocks in the CFC charts.

You use extensive libraries with premade instructions and blocks. This means that
instructions and blocks do not need to be programmed. The likelihood of errors is reduced.

The "CFC" editor supports you with these functions when creating the user program:
¢ Automatic creation of the user program for all CFC charts

¢ Transfer of the user program to the device of the target system

You use CFCin particular for process engineering or structured automation solutions.

You interconnect, for example, blocks you have created yourself or instructions supplied by
CFC with the operands of your target system.

With the help of a CFC chart, even a complex user program remains clearly laid out.

You can monitor process values as well as input and output parameters of the instructions
and blocks online for testing.

Type and instance (Page|29)

Configuration options for CFC charts (Page|26)
Overview for configuration of CFC charts (Page 63)
"CFC" Editor (Page 45)

Basic settings for CFC charts (Page|43)

Icons in CFC (Page|53)

System Manual, 11/2023, A5E53466205-AA
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2.2 Configuration options for CFC charts

2.2

Configuration options for CFC charts

Configuring CFC charts

In the "CFC" Editor, you configure the CFC charts either graphically by dragging and dropping
with the mouse or textually in the form of a list.

You can change from one configuration method to the other at any time with no restrictions.

When you create user programs with CFC, we recommend that the block programming is
complete and that the block types are no longer changed.

Graphic configuration of CFC charts in "Data flow" mode

When you configure graphically in "data flow" mode, you insert instructions and blocks in the
CFC chart from a library, for example.

You interconnect the input and output parameters with drag-and-drop, via a mouse click or
by using a keyboard shortcut and click.

To document the CFC chart, you use text boxes.
The advantages of graphic configuration compared with textual configuration are as follows:

¢ Simple wiring of input and output parameters using drag-and-drop, a mouse click,
or a keyboard shortcut

e Graphic representation of the signal path

¢ OQOutline of complex charts in chart partitions

Textual configuration of CFC charts in "Control flow" mode

See also

26

With the textual configuration method in "Control flow" mode, you insert the instructions and
blocks in a list.

The input and output parameters are not interconnected graphically, but you will assign
values to the parameters.

The advantages of textual configuration compared with graphic configuration are as follows:
¢ Simple adaptation of the run sequence

¢ Simple parameter assignment

Basics of CFC (Page 25)
"CFC" Editor (Page 45)

Configuring CFC charts
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2.3 Instructions and blocks

2.3 Instructions and blocks

With CFC, you create user programs by simple placement, parameter assignment and
interconnection of instructions and blocks in the CFC charts.

When you create user programs with CFC, we recommend that the block programming
is complete and that the block types are no longer changed.

Distinction between instructions and blocks

The designation depends on how they are created and the target system, for example.

Instructions

Instructions are predefined, basic functions, such as logic operations and arithmetic
functions.

Instructions are program components of CFC and are available in the "Instructions” task card.

Blocks
You can create blocks yourself or use predefined blocks from the library.
¢ Function blocks (FB):

Function blocks are code blocks that store their values permanently in instance data
blocks.

The values are still available after the block has been processed.

The data are available and accessible during processing across multiple cycles.
¢ Functions (FC):

Functions contain program routines for recurring tasks.

They have no data memory in which values of block parameters can be stored.

Therefore, when a function is called, all formal parameters must be assigned actual
parameters. A data block is not required.

You can also interconnect the parameters of function blocks and functions with elements of
global data blocks.

Blocks for the S7 target system

There are other block types in the S7 target system.

Additional information: "Working with CFC charts for S7 > Blocks in CFC charts for S7"

Configuring CFC charts
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2.3 Instructions and blocks

Properties of instructions and blocks

28

There are additional terms associated with instructions and blocks:

Type and instance
e Atypeis areusable, pre-defined block.

The block can be provided in a library or you can create it yourself.
* Aninstance is a use of a type, for example, in the CFC chart.

Additional information: "Type and instance (Page|29)"

Generic instructions

The number of inputs is variable in generic instructions and can be changed in the CFC chart,
for example, AND logic operation.

Additional information: "Adding or removing input parameters (Page 148)"

Family

The instructions/blocks are grouped according to their function characteristics, the instruction
or block families, e.g. CONVERT.

Configuring CFC charts
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2.4

2.4 Type and instance

Type and instance

Type-instance concept

Type

Configuring CFC charts

Configuration in CFC is made easier by using types or their instances.

A block type is a reusable, pre-defined function that you yourself create or copy
from a library.

You create a block instance by inserting a block type into a CFC chart.

The advantage of this type-instance concept is that you can implement any central change
of the type at a later time at all instances.

A type can be defined by the following options:

¢ When inserting a block from the "Program blocks" folder in the project tree into a
CFC chart.

The block in the "Program blocks" folder is imported into CFC and defined as type.
The "copy" in the CFC chart is an instance of this type.
¢ A block that you want to define as type is saved in one of the libraries.
This can be a block from the "Program blocks" folder, for example, or from a CFC chart.

If this saved block is added to a CFC chart from the library, the block is imported in CFC
and defined as type.

The "copy" in the CFC chart is an instance of this type.
A type can already be defined as supplied block in a library.
Central type change

When you change the type, you can update the instances of this type in all CFC charts of a
target system.

Additional information: "Central change of a type (Page 116)"

Note
Delete block type: Check instances

First delete the instances followed by the block type.

If you delete a type of which an instance still exists, then you will no longer be able to
compile the CFC charts of this target system.

You may find the information on the missing block types in the alarms of the Inspector
window or in the "Chart sequence & extras" editor.
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2.4 Type and instance

Instance

See also

30

An instance is the use of a type in the CFC chart.
You can create any number of instances from a type.

Within a CFC chart, each instance has a unique name. The instance name consists of the
name of the CFC chart in which the instance is located, the name of the type and the instance
number.

The instance normally inherits the defaults of the type, for example, the default values of the
parameters.

During configuration, you can enter individual initial values, change the instance name and
interconnect the input and output parameters.

Adding an instruction or block to the CFC chart (Page/109)
Updating instances of a changed block type (Page 120)
Creating a block type for CFC (Page 122)

Configuring CFC charts
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2.5 Hierarchical CFC charts

2.5 Hierarchical CFC charts

You can create CFC charts in hierarchical structures.

In doing so, you add one or more CFC charts as "subcharts" into a "basic chart".

Nesting depth
A subchart can contain additional subcharts so that you are creating a nested hierarchy.
Maximum nesting depth of hierarchical CFC charts:
¢ 8 hierarchy levels:

Basic chart + 7 subcharts

Managing hierarchical CFC charts
When inserting a CFC chart as subchart, a copy of the inserted chart is created under the basic
chart.
Editing subcharts

The original, added CFC chart and the newly created subchart are edited independently of
one another.

Changes in the subchart do not affect the originally inserted CFC chart and vice versa.

Copying or moving subcharts
The hierarchical CFC charts can be handled like blocks.
You can copy or move subcharts within a chart or to another basic chart.

If the selected subchart contains additional subcharts, these are copied or moved as well.

Deleting hierarchical charts

When you delete a CFC chart that was inserted as subchart, the subchart is retained.
When you delete a subchart that contains additional subcharts, these charts are deleted as
well.

Replacing subchart

You can replace a hierarchical CFC chart with a different hierarchical CFC chart.

If possible, the existing interconnections are retained.

The position in the run sequence is not changed.

Additional information: "Replacing hierarchical CFC charts (Page 90)"

Changing layers
You can elevate a subchart to the root level in the "Charts" folder.
In this case, however, the chart interface may not have an external interconnection.

Additional information: "Moving subcharts to the root level (Page 91)"

Configuring CFC charts
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2.5 Hierarchical CFC charts

Representation in the project tree
Hierarchical charts are displayed in the project tree in the "Charts" folder.
A basic chart is indicated using a folder icon.

The actual basic chart and all subcharts are displayed in this folder. When a subchart contains
additional subcharts, this subchart is also displayed as a directory.

To open a basic chart, double-click the "Chart" icon below the chart name: j#
Example

= [igj Charts
ﬁ Add new chart
i’ Chart sequence & extras
io} crc_ 1
~ [ja CFC_2
M Chart
ot crc1
0k crc 2
> gk CFC_2_1
M Chart
Intcrc 2 2
ot crC 4
jntcrc 2 2
Ik crC 4
0} cFc 3
IO} crc_4

The chart "CFC_2"is a basic chart that contains the subcharts "CFC_1", "CFC_2", "CFC_2_1",
"CFC_2_2"and "CFC_4".

The subchart "CFC_2_1", in turn, is the basic chart for the contained subcharts "CFC_2 2" and
"CFC_4".

The subcharts called "CFC_4" were created as independent copies by inserting the chart
"CFC_4". To avoid confusion, assign meaningful names to the subcharts.

Configuring CFC charts
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2.5 Hierarchical CFC charts

Visualization of the subcharts in the basic chart

A subchart is visualized in a higher-level chart similar to a block with "subchart header" and
"chart interface".

However, a different icon is used in the "subchart header".

The following figure shows a section of the subchart "CFC_2_1" that is included in the basic
chart "CFC_2".

The subchart "CFC_2_1" contains the subcharts "CFC_4"and "CFC_2 2"
¢ Only the standard parameter EN exists at the subchart "CFC_4".

¢ The parameters that are defined in the chart interface are displayed in the subchart
"CFC_2_2".

» CFC 2 » CFC 2 1

] @3 [io0% M =
CFC 4
CFC
1—EN
I‘D-E CFC 22
CFC
|
1—EN OutChart_Byl——
InChart_ By

Navigation within the hierarchy
The following navigation options are available in the CFC charts:
¢ Navigation "down":
— With double-click on the subchart icon.

— Select the subchart icon and execute the "Open"” menu command from the shortcut
menu.

¢ Navigation "up":
— Execute the "Open parent chart" from the shortcut menu in the opened subchart.

— Double-click a sheet bar entry that contains an interconnection to the interface of this
subchart.

Use the entry "Back” in the shortcut menu to jump back to the last selected parameter.

Configuring CFC charts
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2.5 Hierarchical CFC charts

Interface of the CFC chart

Hierarchical CFC charts and standard CFC charts have an interface structure that is similar to
that of blocks. This means that these CFC charts can be configured and interconnected
externally similar to blocks.

The chart interface is displayed in the top area of the data flow and control flow section in the
"CFC" editor. When the "Interface" area is hidden, enlarge the area with the mouse or click the
unhide icon: E=r ==

New parameters can be added, modified or deleted in the Input, Output, InOut sections of
the chart interface.

Interconnections of interface parameters with blocks within the CFC chart are displayed in the
sheet bar of the chart with connectors.

Additional information:
¢ "Adding, editing and sorting parameters of the chart interface (Page(92)"

* ‘"Interconnections to parameters of the chart interface (Page|144)"

Jump to the interconnected parameter

34

The shortcut menu of a parameter at the subchart icon contains the menu command "Track
signal”.

The menu command "Track signal” opens the subchart and selects the interconnected
parameter of the block.

You use this command to track the signal from the chart interface into the inside of the chart.

If multiple parameters are interconnected, select the required parameter from the shortcut
menu.

Use the entry "Back” in the shortcut menu to jump back to the last selected parameter.

Configuring CFC charts
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2.5 Hierarchical CFC charts

Interconnections in a hierarchical CFC chart

Run sequence

See also

Configuring CFC charts

You configure the interconnections in a hierarchical chart via the chart interface or directly to
blocks in the chart.

When you move a block with an interconnection to the chart interface to a different CFC
chart, the existing interconnection to the interface is deleted.

The following rules apply to interconnections between the parameters in the block and in the
chart interface:

You can only interconnect parameters from the same section of the chart and block
interfaces.

Example: An Input parameter of the chart interface is interconnected with an Input
parameter at the block.

Alternatively, you can interconnect the Input parameter of a block with an InOut
parameter of the chart interface.

The data types of the interconnected parameters and of the blocks are subject to the same
conditions.

On the S7 target system, it is not possible to interconnect individual elements of a STRUCT
parameter type with the chart interface.

Interface parameters of the Output type cannot be configured directly.

Enter the value at the interconnected output parameter.

The run sequence of the blocks is bound to the CFC chart.
Hierarchical CFC charts can be handled like objects within the run sequence.
Subcharts inherit the task assignment of the basic chart by default.

If a subchart that has further subcharts has a different task assignment, this different task
assignment is inherited by all child subcharts.

The "Reduction ratio" and "Phase shift" functions are only available for basic charts.

The subcharts are called in the run sequence in accordance with their associated basic
chart.

The "Enable chart" function is available for subcharts.
Requirements for processing the lower-level subcharts:

— The "Enable chart" setting is also set in the basic chart.

Creating a subchart for a hierarchical CFC chart (Page 88)

Overview of textual interconnections (Page 158)

Managing CFC charts and groups (Page 77)
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2.6 Protection from unintentional access to CFC charts

2.6

Overview

Principle

36

Protection from unintentional access to CFC charts

To protect a CFC chart or hierarchical CFC chart from unintentional editing, you can protect
the chart with a password.

The contents of the CFC chart can only be viewed after the correct password has been
entered.

NOTICE

Password: No authorization, no know-how protection of the charts
The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
* Protection against unauthorized access to know-how in CFC charts
» Security-relevant authorization for access to CFC charts

You will be asked for the password when you open the CFC chart.

The password-protected CFC chart can be handled as normal as long as it remains open in the
editor.

Once password protection has been set, the current password must be entered to change or
remove the password.

Hierarchical charts
Setting or removing a password for a basic chart does not affect the passwords of subcharts.

If subcharts are password-protected, you will need to enter the password again when you
open these charts.

As soon as a password is assigned to a basic chart, the behavior changes:

* Aslong as the basic chart is closed, the hierarchical view remains hidden in the project
tree

e For subcharts which do not have their own password, the "Access protection” entry in the
shortcut menu is hidden.

The "Protection” button is disabled in the chart properties.

To protect one of the subcharts from unintentional editing, open the subchart. In the
project tree, the "Access protection” entry is displayed in the shortcut menu of the
subchart. The "Protection” button is enabled in the chart properties.

Configuring CFC charts
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2.6 Protection from unintentional access to CFC charts

Properties of a CFC chart with password protection

Without a valid password, you only have limited access to the chart:

More information

Configuring CFC charts

The content of charts and subcharts is not visible.

References to chart contents via direct object selection with the mouse or text input are
not possible.

Compiling and loading is possible without entering a password.
During a type update, instances in password-protected charts are also updated.
Password input is not necessary for this.

You can copy the chart without entering the password.

The copied chart has the same password, however.

The display of the chart properties in the Inspector window is limited.
Users can only change the name and comment.

All other properties are either not visible or cannot be changed.

The chart interface is displayed as read-only.

The following parameter assignments can be applied:

— Value

— "Invisible" property

— Test settings

— External interconnections to the chart interface

The printout comprises only the chart interface and the limited information on the chart
properties.

Activating password for a CFC chart (Page 82)
Changing or deactivating password for a CFC chart (Page 83)
Opening a password-protected CFC chart (Page 85)

System Manual, 11/2023, A5E53466205-AA 37



Introduction and basics

2.7 Multilingual texts in CFC

2.7

Multilingual

Multilingual texts in CFC

The following languages are present in a project:
¢ Editing language
Each project has an editing language.
Any text you enter is always created in the editing language.
* Project language
Project languages are all languages in which a project will later be used.

Based on the editing language, all texts can be translated into the various project
languages.

Editing language and project languages are configured in the project tree folder
"Languages & resources" > "Project languages".

Note
User interface

The language of the user interface does not depend on the editing and project language.

Multilingual texts in CFC
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You can manage the following types of text in CFC in several languages:
e Comments from:

— CFCchart

— Instance

— Parameters
* Text block

You enter these texts in the "CFC" editor when you create the CFC chart in the editing
language.

These texts are then translated into the required project languages in the project text editor
of the TIA Portal.

Configuring CFC charts
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2.7 Multilingual texts in CFC

Translating texts
There are different ways of translating texts:
¢ Translating texts directly

You can enter the translations for the individual project languages directly in the
"Project texts" table.

¢ Translating texts using reference texts
For smaller amounts of text, you can change the editor language.

All the text cells are filled again with the default values and can be filled in the
current language.

More information in the information system of the TIA Portal:

e "Editing project data > Working with multi-language projects"

User interface language: Installing language packs
You can install additional interface languages using TIA Administrator:
1. Install the TIA Portal language packs for the desired user interface languages.
2. Select the tiles for the "SIMATIC STEP 7 CFC" language pack.

3. Load and install the CFC language pack for the installed TIA Portal user interface languages.

Configuring CFC charts
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2.8 Copying objects

2.8 Copying objects

Copy and paste

Copying objects

Copying objects

Copying objects

Moving objects

See also
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You can copy within the TIA Portal either by dragging with the mouse or using the "Copy" and
"Paste"” commands.

If you want to copy an object in the same area by dragging it with the mouse, you can do this
by holding down the <Ctrl> key.

All selected objects are copied.

within a device
If you copy one or more objects within a device, the copies are numbered in ascending order.

If an object with this naming convention already exists, this number is skipped.

Example:

The chart folder contains the objects "Tag", "Tag_1" and "Tag_34".
If you copy "Tag", the copy is given the name "Tag_2".

If you copy "Tag_34", the copy is given the name "Tag_3".

to a different device
If you copy one or more objects to a different device, the object names are not changed.

If there is already an object with the same name at the destination location, you will be
prompted to decide what to do.

to a different project

To copy objects from one project to another, open the second project in a second instance of
the TIA Portal.

When you copy, the principles are the same as when copying to a different device.

To move objects from one project to another, copy the objects.

Then delete the source object manually.

Copying instructions, blocks and charts (Page|107)

Overview of textual interconnections (Page 158)

Configuring CFC charts
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2.9 CFC naming conventions

2.9 CFC naming conventions

Permitted characters
Special characters and umlauts are allowed in chart names and in instruction names.
However, to avoid compatibility problems, only use the following characters:
e Characters from "a" to "z"
¢ Numbers from "0" to "9"

e Underscore" " for separation

Control characters for path and hierarchy information

There are control characters reserved for path and hierarchy information and that are used,
for example, in "control flow" or in connectors.

The control characters are relevant only for path and hierarchy information. Outside this
context, the control characters are interpreted as permitted parts of a name.

The following table shows the reserved control characters:

Control character Explanation
Dot . Reserved for path and hierarchy information.
Slashes l'and \ e The dot indicates parameters at instructions/blocks.

e The slash represents hierarchical relationships.
Example:

The expression "Chart_1\Block_1.IN_1" addresses the input parameter "IN_1"
of the instruction "Block_1"in chart "Chart_1".

Quotes ! Reserved for starting and completing a character string.
Percent sign | % Reserved for starting address ranges.
Dollarsign | $ Reserved as the escape character.

The control character following this is interpreted as a permitted character.

Control characters as parts of names

If you edit chart and instruction names with control characters in the path or hierarchy
information, use the following syntax:

¢ Enter the name in quotes.
Example:
"Motor1.Temperature"
* Precede the control character with the escape character $.
Example:

— Motor1$.Temperature

Configuring CFC charts
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2.9 CFC naming conventions

Example

In the CFC chart "TempControl", the "Motor1.Temperature" instruction is configured for
temperature control of a motor.

The naming convention of the plant owner defines the dot as a separator.

To address the output parameter "OUT" of the instruction in "control flow", the following
notations are permitted:

* TempControl\"Motor1.Temperature".OUT
» TempControl\Motor1$.Temperature.OUT

Configuring CFC charts
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3.1 Basic settings for CFC charts

The basic settings of CFC charts refer to all charts that you have configured in a target system.

Default settings for new charts

Configuring CFC charts

You define the basic settings for new charts in the "Options > Settings > Charts" menu.

You can change the properties of each CFC chart at any time regardless of the basic settings.

Basic settings
The following settings are specified when you create new charts:
¢ Independent of the target system:
— Color of interconnection lines
* Dependent on the target system:
— Appearance of the CFC charts, e.g. sheet bar settings and layout

— If necessary, additional settings, such as the reserved number ranges for user blocks

Changing basic settings
Changes to the basic settings only affect newly created CFC charts.

Existing CFC charts remain unchanged.

Task assignment of CFC charts
Newly created CFC charts have an assigned main task.

Depending on the target system, you change this task assignment in the
"Chart sequence & extras" editor.

Additional information: "Runtime model (Page 166)"
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3.1 Basic settings for CFC charts

Representation of the CFC chart in the editor

See also

44

If you adapt the zoom factor or the representation of the grid lines in a CFC chart,
these changes apply to all CFC charts you open from this point onwards.

This behavior also applies following a program restart.

Zoom function in the CFC chart

You zoom in the CFC chart with the <Ctrl> key and the mo
The zoom focuses on the position of the mouse pointer.
Alternative zoom options:

¢ Keyboard shortcuts <Ctrl+"+"> and <Ctrl+"-">

* Zoom scale at the bottom of the editor window

* % entry or selection in the drop-down list

Position: in the toolbar or next to the zoom scale

Adding an instruction or block to the CFC chart (Page/109)
Printing a CFC chart (Page 79)

CFC views (Page 66)

Extending a CFC chart (Page 72)

"Chart sequence & extras" Editor (Page 49)

Basics of CFC (Page 25)

use wheel.

Configuring CFC charts
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3.2 "CFC" Editor

3.2 "CFC" Editor
In the "CFC" Editor, you configure CFC charts graphically or as a list.

The two configuration methods have the same priority.
You can change from one configuration method to the other at any time.

Open "CFC" editor
You open the "CFC" editor for the first time by adding a new chart.
1. Open the "Charts" folder in the "Project tree".
2. Double-click "Add new chart".
A new CFC chart is created and opened in the editor.
3. To open an already-created CFC chart in the editor, double-click the chart.

The "CFC" editor always contains a CFC chart when it is opened.

Configuring CFC charts
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3.2 "CFC" Editor

Layout of the "CFC" Editor
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Work area: Display area of the "Data flow" and "Control flow" tabs

Configuring CFC charts
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3.2 "CFC" Editor

Work area with the "Data flow" and "Control flow" tabs
¢ In the "Data flow" tab, you configure a CFC chart graphically.

¢ In the "Control flow" tab, you specify the run sequence of the instructions and blocks in
the CFC chart.

You also display the configured instructions and blocks with their input and output
parameters in form of a list.

You also select the input and output parameters for testing.

¢ Both in "Control flow" and "Data flow" mode, you can insert, interconnect and set
parameters for instructions and blocks.

Task cards
Task card Use
Instructions Access to all instructions provided by CFC.
Libraries Access to the project library and global libraries.
Testing Configure test settings.
Note

Depending on the target system

The availability and the content of the task cards depend on the target system for which you
are configuring.

Configuring CFC charts
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3.2 "CFC" Editor

Inspector window

See also
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Additional information on a selected object or executed actions are displayed in the Inspector
window.

The Inspector window includes the following elements or functions:
« Different tabs, e.g. "Properties", "Info", "Diagnostics":
Information on selected objects is displayed and editable properties can be changed.

In the "General" tab, you can enter additional details on the CFC chart, a comment or
version information, for example.

¢ Additional lower-level tabs in the "Info" and "Diagnostics" tabs

Alarms and warnings are displayed in the "Info" tab, for example, during compiling or
loading.

¢ Navigation functions within the tabs

You use the Inspector window for the following tasks:

* Set parameters of the instructions/blocks.

* Select parameters of the instructions/blocks for testing.

* Manage interconnections

Note
Depending on the target system

The properties or options in the Inspector window depend on the target system for which you
are configuring.

Basic settings for CFC charts (Page 43)

Configuration options for CFC charts (Page|26)

Overview of CFC instructions (Page|286)

Selecting parameters for testing (Page 176)

Adding an instruction or block to the CFC chart (Page/109)
"Chart sequence & extras" Editor (Page|49)

Overview for configuration of CFC charts (Page 63)
Keyboard operation in CFC (Page 51)

Icons in CFC (Page 53)

Configuring CFC charts
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3.3

Overview

Tab

Table layout

Configuring CFC charts

3.3 "Chart sequence & extras" Editor

"Chart sequence & extras" Editor

In the "Chart sequence & extras" editor, you configure the run sequence of charts.

The assignment of the instructions/blocks to the tasks and therefore the run sequence within
the target system is also displayed.

Note
Depending on the target system

The availability and the content of the tabs depend on the target system for which you are
configuring.

You are working in various tabs of the editor.

Depending on the target system, the following tabs are displayed:

¢ "Chart sequence": Run sequence of the CFC charts

¢ "Task assignment": Tasks and assigned blocks

¢ "Tag interconnections": Points of use of interconnected tags and global data blocks
¢ "Target system settings": Basic settings for chart folder

¢ "Block instances": Block types with their associated instances

Tabs that are not supported by the target system are not visible.

Information on S7 target systems

* "Working with CFC charts for S7 > "Chart sequence & extras" editor for S7"

In most tabs, you are working in a table.
Depending on the selected tab, you can adapt the representation of the columns in the table.
e Column width:

— You change the width of the individual columns with the mouse.

— You optimize the column width automatically via the shortcut menu.

¢ To change the sequence of the columns, move a column header with a drag-and-drop
operation.
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3.3 "Chart sequence & extras" Editor

See also
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Basic settings for CFC charts (Page 43)

"CFC" Editor (Page 45)

Keyboard operation in CFC (Page 51)

Icons in CFC (Page 53)

Displaying points of use of interconnections (Page|153)

Adapting the run sequence (Page|166)

Configuring CFC charts
System Manual, 11/2023, A5E53466205-AA



Elements and basic settings

3.4 Keyboard operation in CFC

3.4 Keyboard operation in CFC
In the TIA Portal and in CFC, keyboard shortcuts are also available for many functions.

Alternatively, you can use user-defined keyboard shortcuts.

Keyboard shortcuts in CFC

The following shortcuts enable operation without the mouse:

Function Keyboard shortcut | Menu command

Go to the next open CFC chart <Ctrl+F6>

Go to the previous open CFC chart <Ctrl+Shift+F6>

Go to the next chart partition, if more than <Shift+PgDn>

one chart partition has been created

Go to the previous chart partition, if more <Shift+PgUp>

than one chart partition has been created

Project tree: <Ctrl+Arrow up>

Go to the next CFC chart

Project tree: <Ctrl+Arrow down>

Go to the previous CFC chart

Openl/close project tree <Ctrl+1> View > Project tree
Openlclose task card <Ctrl+3> View > Task card
Openl/close detail view <Ctrl+4> View > Detail view
Openlclose Inspector window <Ctrl+5> View > Inspector window
Display or hide reference projects <Ctrl+9>

Download project data to the device <Ctrl+L> Online > Download to device
Open Help <F1> Help > Show help

Open help on a block <Shift+F1>

TIA Portal: Operation with the keyboard

You can find an overview of all keyboard shortcuts and the option of assigning user-defined
keyboard shortcuts in the settings of the TIA Portal:

1. Select the "Settings" command in the "Options" menu.
The settings of the TIA Portal are displayed.
2. Open the "Keyboard shortcuts" entry in the area navigation.

You can see an overview of all default and user-defined keyboard shortcuts that are valid
for the currently installed products.

More information in the TIA Portal Information System:
¢ "User interface and operation > Keyboard operation in the TIA Portal"

You learn how to navigate in the TIA Portal using the keyboard, edit objects and customize
the TIA Portal to your needs.

Configuring CFC charts
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3.4 Keyboard operation in CFC

See also
"CFC" Editor (Page 45)
"Chart sequence & extras” Editor (Page 49)

Configuring CFC charts
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3.5 Icons in CFC

3.5 Icons in CFC

The tables below show the icons that you use when working with CFC and describe their
meaning.

Configuring CFC charts

TIA Portal project tree: CFC charts

— lcons under the "Charts" entry

— Online/offline comparison status

Project tree | Trend editor: Trend display/Dynamic display
Project tree / Toolbars: Other icons

CFC editor: Toolbar

CFC editor: Chart view in the "Data flow" tab

— lcons at the block instances

— Interconnections

— Othericons

"Chart sequence & extras" editor

— General

— "Chart sequence" tab

— "Textual interconnections” tab (S7 target system)
— "Block types" tab (S7 target system)

"Update blocks" dialog

System Manual, 11/2023, A5E53466205-AA 53



Elements and basic settings

3.5 Icons in CFC

TIA Portal project tree: CFC charts

Icons under the "Charts" entry

Icon

Meaning

> ot

Navigation area for managing CFC charts

[

Opens the "Chart sequence & extras” editor

"

Creates a new CFC chart.

=]

CFC chart:
Opens the chart in the CFC editor.

E?

Hierarchical CFC chart:
Icon for a group of hierarchical charts, consisting of the basic chart and subcharts

Hierarchical CFC chart:
Opens the basic chart in the CFC editor.

Password-protected CFC chart
The password serves only to protect a CFC chart from unintentional editing.

Password-protected hierarchical chart
The password of basic charts does not affect the subcharts contained therein.

To protect the subchart of a protected basic chart from unintentional editing,
open the subchart. In the project tree, the "Access protection” entry is displayed
in the shortcut menu of the subchart.

Online/offline comparison status

The icons for the status display identify whether changes exist in the project and a download
to the device is required.

Icon

Meaning

e

The CFC chart exists in the project but not in the device.

| =]
o

The basic chart exists in the project but not in the device.

ol

The CFC chart is identical in the project and device.

E?

The basic chart is identical in the project and device.

The CFC chart has been changed in the project and exists in the device but is different.

The basic chart has been changed in the project and exists in the device but is different.

The basic chart is identical in the project and device, but a subchart has been changed.
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3.5 Icons in CFC

Project tree / Trend editor: Trend display/Dynamic display

Icon Meaning
y B3 Project tree:
Navigation area for the "Trend display", "Dynamic display", "Force table" components
E Project tree:
Creates a new trend display or dynamic display
= Project tree:

Opens the dynamic display in the table editor
Project tree:

Opens the trend display in the trend editor
e Trend editor:

Adds an analog axis in the trend display

5 Trend editor:

Adds a digital axis in the trend display

Project tree / Toolbars: Other icons

Icon Meaning
= Opens the force table.
You find the entry in the project tree under "Charts - Trend/dynamic display & force table"
o Refreshes the display
The icon is used in multiple editors and views.
=51 TIA Portal toolbar:
Split editor area horizontally or vertically
Use the split editor areas to drag interconnections between charts or chart partitions.
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CFC editor: Toolbar

56

Icon Meaning
P r= | List of created chart partitions in the open CFC chart
== e | Clicking on an entry changes the view to the selected chart partition.
[Fartition 2_____|
& Create new chart partition
% Delete displayed chart partition
Requirement: The CFC chart consists of at least 2 chart partitions.
® 3 Zoom in Jout on the display of the CFC chart:
e Zoomin
¢ Fit chart to work area
* Fit selection to work area
¢ Zoom out
1 Open displayed CFC chart in a second editor window
This can be used, for example, to simultaneously edit two chart partitions
of the same CFC chart.
L Select sheet bar view:

e Static sheet bars
¢ No sheet bars

¢ Dynamic sheet bars

Select display of sheet bar entries:
¢ One-line

¢ Two-line

Show [ hide sheet borders
Requirement: The chart or chart partition is divided among at least 2 sheets.

Show [ hide sheet numbers

Show [ hide grid in chart background

Show / hide position number in the run sequence above the block header.

Show [ hide assigned task above the block header.

= Show [ hide unit of measurement of the parameters
Requirement: A unit of measurement has been configured for the parameter.

i Signal flow highlighting: The signal flow is highlighted in color.
Requirement: The instance of a block or subchart has been selected.

= Change between the display of parameter names and comments
Requirement: A comment has been entered for the parameter.

o Insert new subchart

iy

& Insert text box

Configuring CFC charts
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3.5 Icons in CFC

Icon Meaning
S Optimize run sequence in a CFC chart according to the signal flow
=z Place blocks in the displayed chart according to the data flow
= Show selected object in the control flow
=2
[vererbt (Cyclic intdal Task assignment of the open CFC chart
o Monitoring on/off
Activates the display of the current values during testing.
If you have connected online, all input and output parameters selected
for testing are supplied with current values from the device and also
highlighted in color.
jm Control flow:
Collapse display and show only the top elements
= Control flow:
Expand display and show all lower-level elements
h}” Control flow:
s Show selected object in data flow

Configuring CFC charts
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CFC editor: Chart view in the "Data flow" tab

58

Icons at the block instances

Icon

Meaning

£

Identifies the instance of a function block (FB) in the open chart.

Identifies the instance of a function (FC) in the open chart.

ol

Identifies the instance of a subchart in the open chart.

Without icon /

= o

Instances of instructions can be marked with different icons or only with
the instruction name.

Identifying instruction instances: The entry "Go to block type" is missing
in the shortcut menu of instruction instances.

1 &
b

Colored border:
The instance has been positioned automatically in the chart.

Instances with a colored background:
Not enough space for a complete display or the objects lie on top of each other.
Move the instance or increase the sheet size.

Block is not processed.

The reason is that the enable input "EN" at the block is "FALSE" or the
"Enable chart" option of the chart has been disabled.

Block is processed conditionally.

The reason is that the enable input "EN" at the block or the "Enable chart" option
of the chart has been interconnected.

An interconnected parameter is hidden.

F
5 A non-interconnected parameter is hidden.

Add additional input parameters at an instruction instance

The icon is hidden in the following cases:

* Addition is not possible.

e The maximum number of possible input parameters has been reached.
'S Connector display for an interconnection that cannot be fully displayed:

* Light beige: The destination connector lies within the sheet or

in the sheet bar.
» Dark beige: The destination connector lies in the extended sheet bar.
The interconnection is represented by connectors with the same numbers.
To jump between the connectors, double-click the corresponding connector.

Status display for the "Forcing” function
¢ Brown (online) / light brown (offline):

The "Add forcing" option has been enabled.
¢ Blue (online) / light blue (offline):

The "Add forcing" and "Forcing active" options have been enabled.

Configuring CFC charts
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Interconnections in the data flow

The color of the interconnection lines depends on the data type of the data source.
You select the colors in menu "Options > Settings > Charts > CFC > General".

For interconnections to operands whose data type is not defined, the default value "black"

is used.

Icon

Meaning

—lincuip

™= lincoomn
—maxCount

— minCount

Create interconnections

When you move the mouse over the input parameters, the interconnectable
parameters are displayed with a green background.

The selected parameter is displayed with a light green background.

Colored signal flow marking

Requirement: The "Highlighting for signal flow" option has been enabled
in the toolbar.

Interconnections in online mode

For BOOL-type interconnections, the display of interconnection lines in online
mode is dependent on the current value.

e Green line: Value ="1"
¢ Dashed blue line: Value ="0"

Identifies textual interconnections in the sheet bar

Configuring CFC charts
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Other icons
Icon Meaning
Shows and hides window areas
V=T =
100 % = Footer:
Select zoom factor of work area
M Footer:
T .
Slider for zoom factor of the work area
& Footer:
Opens a window for navigation in the chart
Inheritance status of attributes of a selected parameter in the
Inspector window (tab "Properties > General")
e The value of the attribute is handed down from the type
to the instance.
ot Inheritance status of attributes of a selected parameter in the

Inspector window (tab "Properties > General")
e The value is not handed down from the type to the instance
because it was changed at the instance.

To restore the inheritance, click on the icon.

Objectiparameter Operand Data flow: ) . )
- 48-FB 01 011 Open textual interconnections of interface parameters have
= e the background color "yellow" in the "Operand” column.

in_intd1:= 0
in_int02:= . b 3 1ou._

Narne Data type Chart interface:

% = CFCZINT | Int As long as an interfa"ce parameter has not bee"n intercon"nected,
the table cell of the "Data type" column has a "light gray
background color.

Upon interconnection, the background color changes to
"medium gray".

i = CFC2_BOCOL  EBool
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"Chart sequence & extras" editor

General

Icon Meaning

(m Expand display and show only the top elements
= Expand display and show all lower-level elements
o Refreshes the display

"Chart sequence" tab

Icon Meaning

1 Optimize run sequence of CFC charts

h}” Show selected object in data flow

A

= Show selected object in the control flow
B

"Textual interconnections" tab (S7 target system)

Icon Meaning

Select all displayed textual interconnections

Undo selection of textual interconnections and select no interconnection

Close textual interconnection

2

% Delete textual interconnection

"Block types" tab (S7 target system)

The "Differences" column displays the status of the block in comparison with the block types.

Icon Meaning

° There are no differences between the compared blocks.

No action required.

No instances of this imported block are currently used in the CFC.
Existing differences have no effect in the CFC.

o There are differences between the compared blocks.

The differences are displayed in the Inspector window in the "Properties >
Differences" tab.

0 The block type of the imported block was not found in the block folder.

b

Other status Status information is displayed in the "Properties” tab of the
Inspector window.

Example: i) ] )
Example: The block is not compiled.

Configuring CFC charts
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"Update blocks" dialog

The icons are displayed in the last column of the "Differences" window.

Icon

Meaning

=

No download necessary:
Identifies changed blocks that can be inserted without a download to the CPU.

STEP 7 downloads changed blocks to the PLC where appropriate,
irrespective of CFC.

Download of software necessary

Download with CPU Stop necessary

See also

Basics of CFC (Page 25)
"CFC" Editor (Page 45)

"Chart sequence & extras” Editor (Page 49)
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Configuring CFC charts
System Manual, 11/2023, A5E53466205-AA



Configuring and adapting CFC charts 4

4.1 Overview for configuration of CFC charts

Preparing the configuration

Basic procedure

Configuring CFC charts

There is normally a planning phase prior to the configuration of CFC charts.

During this planning phase, you specify, for example, how the open-loop and closed-loop
control is structured in the CFC charts.

You can, for example, create a separate CFC chart for each measuring point.

With this strategy, you have greater flexibility when reacting to expansions in the plant.

Note
Using the functions "Undo" and "Redo"

Use the "Undo" and "Redo" buttons in the toolbar to undo or redo any basic actions you have
executed in CFC.

The options on how you can influence the actions with the two buttons also depend on the
target system.

Additional information: "Undo" and "Redo" functions in CFC (Page 65)"

1. Create a controller and program block types.
Create a CFC chart, or open an existing CFC chart for editing.
Add and manage objects in the CFC chart, e.g. blocks, instructions, text boxes.

Configure input and output parameters by interconnection or parameter assignment.

ik wWwN

Adapt the run sequence (*):
— Sequence of blocks/instructions within a CFC chart
— Sequence of the CFC charts
6. Compile and download the CFC chart. (*)
You can find additional information in the documentation for the specific target system.
7. Test the CFC chart or user program. (*)

(*): Whether and to what extent you perform these steps depends on the target system you
are using.

Additional information on the S7 target system: "Working with CFC charts for S7 (Page 256)"
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4.1 Overview for configuration of CFC charts

See also
"CFC" Editor (Page 45)
Basics of CFC (Page 25)
Creating a CFC chart (Page 70)
Adding an instruction or block to the CFC chart (Page/109)
Interconnecting input and output parameters (Page|136)
Setting the parameters of the input and output parameters (Page|123)
Adapting the run sequence within the CFC chart (Page 171)
Adapting the run sequence of CFC charts (Page|173)

Configuring CFC charts
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4.2 "Undo" and "Redo" functions in CFC

4.2 "Undo" and "Redo" functions in CFC

Use the "Undo" and "Redo" buttons in the toolbar to undo or redo any actions
you have performed.

Action stack
Every action you perform is saved in an action stack.
When undoing actions, the list is processed from top to bottom.

In other words, if you undo an action that lies further down in the list, all actions
located above it in the list will also be undone automatically.

If you perform a new action, then the redo list is emptied.

Displaying the undo/redo list

The "Undo" button in the toolbar is enabled as soon as you perform an action that
can be undone.

This button is split; you can use the arrow down to open a drop-down list.
It contains all actions of the action stack that you can undo.

If you performed actions in an editor other than the currently displayed editor,
then the corresponding editor will also be displayed as a subheading.

This allows you to always identify the point at which the undo operation is applied.

Points to note
The listed actions empty the action stack.
You cannot redo or undo actions after such an action.
¢ Saving the project

¢ Project management (creating a new project, opening project, closing a project,
deleting a project)

¢ Compile

¢ Restoring blocks

¢ Establishing an online connection

* Download

Additional information in the information system of the TIA Portal:

¢ ‘"Introduction to the TIA Portal > Undoing and redoing actions"

Configuring CFC charts
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4.3 Creating and managing CFC charts

4.3

4.3.1

Overview

Creating and managing CFC charts

CFC views

When configuring a CFC chart, you have the following CFC chart views available:
» CFC chart with static sheet bars

e CFC chart with dynamic sheet bars

* CFCchart without sheet bars

You can change the sheet bar view in the toolbar of a CFC chart as required.

More information: "Changing the sheet bar view of a CFC chart (Page|87)"

CFC chart with static sheet bars

66

A static area is reserved to the right and left in a CFC chart for the sheet bars.

This area is intended solely for sheet bar entries, for example for interconnections
between charts.

The following figure shows a CFC chart with sheet bars:

Motor drive belt ?
“Motor1_ONM... @ & —1 14 and_3.IN1
1
Motaor cutter
“Motor2_ON... <« & — 14 and_3.IN2
[
Sheet bar width

The right and left sheet bars of a chart are always the same width.

You can change the width of the sheet bars by dragging with the mouse or in the
Inspector window of the CFC chart.

To adapt the sheet bar width to the text length of the interconnections, double-click
the boundary line of the sheet bar.

Configuring CFC charts
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4.3 Creating and managing CFC charts

CFC chart with dynamic sheet bars

A CFC chart with dynamic sheet bars displays the sheet bar entries only when required and
has the following features that differ from a CFC chart with static sheet bars:

* You can place instructions, blocks or text boxes in the sheet bar area.
¢ The sheet bar area is not highlighted.
The following figure shows a CFC chart with dynamic sheet bars.

The text boxes are placed in the sheet bar area:

Motor drive beh }
“Motor1_ON.. a | & {4 and_3.IN1
_i
Motor cutter
“Motor2_ON... < | & —] {4 and_3.InM2
_l

CFC chart without sheet bars
The CFC chart is displayed without sheet bars.

Interconnections to other CFC charts or to operands are displayed by connectors. The
connectors are placed next the interconnected input or output parameters.

Interconnections between sheets are displayed as if they were on one sheet.

The following figure shows a CFC chart without sheet bars with sheet borders displayed:

Motor drive belt

"Motorl 0.. ——— o

& "Motor3 0.
Mator cutter “
“Motor2_0... ———— & —

Printing CFCs without sheet bars
Instructions or blocks in sheet borders are not shown completely when printed.

If you configure without sheet bars, make sure that you do not place these objects in sheet
borders.

In this case, show the sheet borders during configuration.

Configuring CFC charts
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Sheet bar extension

If you create more sheet bar entries than there is room for in the sheet bar, then the
sheet bar is automatically extended.

If a sheet bar has been extended, you will see an arrow in the sheet bar at the bottom

of the sheet.

The following figure shows a sheet bar with the arrow for an extended sheet bar:

i EX 1
CTRL_Ex
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JADEADE_W
4GAIN

4T

v
ATM_LAG
JLMN_OFF
AMM_LMMHRA
MM LMNLR

~SPEXOMN_L
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+INT_HMEG

EFR
QP H_ALM [
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PID2ctrl_pid_1.644N0P_EN

L 4

If you click on the arrow, the extended sheet bar is shown.

The extended sheet bar is displayed slightly offset above the sheet bar.

The following figure shows an extended sheet bar.

If you click on the arrow at the top border, you return to the sheet bar.

P
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Representation and signal tracking of interconnections

See also

Configuring CFC charts

Interconnections that cannot be displayed

If the connection line of an interconnection cannot be displayed, the interconnection
is displayed with connectors.

The color of the connector indicates the type of interconnection.
The following color coding can be seen in the figure above:
¢ Connector color "Light beige":

The associated target connector is displayed in the sheet at a parameter or
in the sheet bar.

These are connectors "1" to "5" as well as "7" in the figure.
¢ Connector color "Dark beige":
The selected target connector is displayed in the extended sheet bar.

These are connectors "6" and "8" in the figure.

Signal tracking

If you click on an interconnection or a connector, the interconnection or the associated
connector is highlighted in color.

Interconnections to other sheets are also highlighted.

Additional information on the representation and signal tracking of interconnections:
"Representation and properties of interconnections (Page 127)"

Placing instructions and blocks in the CFC chart (Page|105)
Basic settings for CFC charts (Page 43)

Representation of instructions and blocks (Page 94)
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4.3.2

Overview

Creating a CFC chart

CFC charts always belong to one target system.
A CFC chart is uniquely identified by its name.

The settings, such as sheet number and sheet size, are taken from the basic settings
of charts.

Additional information: "Basic settings for CFC charts (Page 43)"

Display in the overview window
The created CFC charts are displayed in the overview of the project tree.

The column "Author" contains the user who created the chart. To sort by user, double-click
on the column title.

Storage of CFC charts

Requirement

Procedure

70

CFC charts are stored in the project tree under the target system in the "Charts" folder.

You cannot rename the "Charts" folder.

Creating groups
To structure the storage of CFC charts, create groups within the "Charts" folder.
Storing CFC charts in groups has no effect on interconnections or the run sequence.

Additional information: "Managing CFC charts and groups (Page|77)"

* The target system has been created.

e The Inspector window is open.

1. Double-click "Add new chart" in the project tree.
The CFC chart is added to the "Charts" folder and displayed in the editor window.
— The configuration data are displayed in the Inspector window in the "Properties” tab.
— The chartinterface is displayed in the top area of the editor window.

In the "Interface" area you create, delete and interconnect the parameters of the CFC
chart.

You can create interconnections to other CFC charts and block elements.
2. Under "General", enter a meaningful name for the CFC chart in the Inspector window.

3. If necessary, change the sheet number and sheet size under "Sheet bars/layout".

Configuring CFC charts
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S7 target systems: Advanced settings
1. If necessary, change the assigned main task under "S7 specific > Sequence".

2. If necessary, change the settings for the run sequence.

Result

The CFC chart has been created and is open in the work area of the CFC editor.

Additional information on the CFC editor: ""CFC" Editor (Page 45)"

See also
Create CFC chart partitions (Page|74)
CFC naming conventions (Page 41)
Changing the sheet bar view of a CFC chart (Page 87)
Runtime model (Page 166)
Options for determining the run sequence (Page|168)
Extending a CFC chart (Page 72)
Adding an instruction or block to the CFC chart (Page 109)
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4.3.3 Extending a CFC chart

Overview

When it is created, a CFC chart consists of a sheet on which you place and interconnect
instructions and blocks.

If there is not enough space for placing or displaying interconnections, extend the CFC chart.

You can extend an existing CFC chart in the following ways:

Requirement

Procedure

—_

> wN

Increase the number of sheets, for example in the vertical direction.
Increase the sheet size, for example from A4 to A3.

Add chart partitions.

Additional information: "Create CFC chart partitions (Page 74)"

The CFC chart is open.
"Data flow" is displayed.

The Inspector window is open.

. Click in a free area of the CFC chart.

Select the "General" tab in the Inspector window.

Select the "Sheet bar/Layout" entry in the area navigation.

To extend the CFC chart, increase the number of sheets or enlarge the sheet size.
Change the vertical and horizontal outline of the sheets, if necessary.

The layout settings apply to all chart partitions of a CFC chart.

. To display all sheets for an overview, select the zoom view "Fit to screen”.

Alternatively, switch to this view with a double-click in the sheet background.

With a double-click in a sheet, you switch from the overview to the clicked sheet.

Alternative procedure

You can also increase the number of sheets by dragging with the mouse.

If you move an instruction or a block beyond the borders of the sheet with drag-and-drop,
the number of sheets increases automatically.

72

Configuring CFC charts
System Manual, 11/2023, A5E53466205-AA



Configuring and adapting CFC charts

4.3 Creating and managing CFC charts

Reducing the number of sheets or sheet size

Result

See also

Configuring CFC charts

When you reduce the sheet size or the number of sheets, some objects may be located
outside the new sheet borders.

These objects are automatically positioned in the remaining area.

If the area is not large enough for all objects, the objects are placed at the top left
in the CFC chart.

Increase the number of sheets and place the objects manually.

The CFC chart is extended.
Use the following keyboard shortcuts to navigate between sheets:
e <Ctrl+Right/Left>

e <Ctrl+Top/Bottom>

Placing instructions and blocks in the CFC chart (Page|105)
Representation and properties of interconnections (Page|127)
Managing CFC charts and groups (Page 77)

Basic settings for CFC charts (Page|43)

Create CFC chart partitions (Page|74)
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43.4 Create CFC chart partitions

Overview

When it is created, a CFC chart consists of a sheet on which you place and interconnect
instructions and blocks.

If there is not enough space for placing or displaying interconnections, extend the CFC chart.
You can extend an existing CFC chart in the following ways:

¢ Add chart partitions

* Increase the sheet size or the number of sheets

More information: "Extending a CFC chart (Page|72)"

Working with chart partitions
You work in chart partitions as you do in the sheets of a CFC chart.

You can interconnect and move instructions and blocks between the chart partitions.
The placement in chart partitions has no effect on the control flow.

When you add a block to the control flow, the block is placed in the first chart partition.

Chart partition names

You can give each chart partition its own name:
e Maximum 15 characters

¢ The name must be unique in the CFC chart.

* The name is always language-neutral.

Configuration limits
A CFC chart contains a maximum of 6 chart partitions with up to 6 sheets each.

When you add additional sheets to a chart partition, this setting also applies to all the other
chart partitions of the CFC chart.

Configuring CFC charts
74 System Manual, 11/2023, A5E53466205-AA



Configuring and adapting CFC charts

Requirement

4.3 Creating and managing CFC charts

Navigating between chart partitions

When you open a CFC chart for the first time after starting the TIA Portal, the first
chart partition is displayed. The name of the chart partition is displayed grayed out.

As soon as you add a second chart partition, the drop-down list "Changes to another
chart partition" is activated. The drop-down list box contains the chart partitions sorted
alphabetically by name.

Navigate between the chart partitions using this drop-down list:

{ Partition_2 |+ :
Partition_1 I
Partition 2 |

Alternatively, change between the chart partitions of the open CFC chart with the following
keyboard shortcuts:

¢ Next chart partition: <Shift+PgDn>
e Previous chart partition: <Shift+PgUp>

The CFC chart is open.

"Data flow" is displayed.

Procedure: Creating a chart partition

Configuring CFC charts

1. In the toolbar, click on the button "Adds a chart partition in the CFC chart": g7
The new chart partition is displayed in the editor.
New chart partitions are always created with the name "Partition_<consecutive number>".

2. To change the name, select the entry "Displayed chart partition" in the "General" tab of the
Inspector window.

Enter a meaningful name and a comment, if necessary.
You can enter up to 1000 characters in the comment field.
3. To return to the previous view, select the desired chart partition in the drop-down list.

4. To delete a chart partition, display this chart partition and click on the button
"Deletes the currently displayed chart partition": ¥

All objects and interconnections of the chart partition are also deleted.
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Procedure: Configuring interconnections between chart partitions

1. Todisplay both chart partitions, click on the button
"Opens the CFC chart in a second window": [Tl

The CFC chart is displayed in two editor windows.
To display both windows, click on one of the buttons for splitting the editor area: — ||
2. Select the required chart partition from the drop-down list.

3. Create the interconnection between the two chart partitions, for example, by using
drag and drop or copy and paste.

The connector at the sheet bar contains the name of the chart partition and the
sheet number.

Alternative procedure: Example "Click Clack"

1. Click on a parameter so that it is displayed in magenta.

2. Use the drop-down list to switch to the required chart partition.
3. Move the mouse pointer to the required parameter.
4

. Click on the parameter as soon as it is displayed in green.

Result

The CFC chart is divided up into chart partitions.

See also
Extending a CFC chart (Page 72)
Creating a CFC chart (Page 70)
Creating a subchart for a hierarchical CFC chart (Page 88)
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4.3.5 Managing CFC charts and groups
The names of a group or CFC must be unique within a target system.

Inside the target system, you can move or copy the CFCs to any other group within the
"Charts" folder.

Add group
Create groups to structure the CFCs in the "Charts" folder.
You can create additional subgroups to an existing group.
1. Select the "Charts" folder or an existing group in the project tree.
2. Select "Add new group" from the shortcut menu.
3. Enter a meaningful name for the group.
4

. Move the CFCs you want to move from the "Charts" folder or another group to the
new group using drag-and-drop.

You can also copy the required CFCs and add them to the new group.

To create a new CFCin a group, select the item "Add new chart" in the shortcut menu
of the group.

Copying a group
1. Select the group you want to copy in the project tree.
2. Select "Copy" from the shortcut menu.

3. Highlight the position of the group you want to create in the project tree within the
"Charts" folder.

4. Select "Paste" from the shortcut menu.

Note
Naming conflicts during copying

If you copy one or more groups, only the group is checked for name conflicts at the
destination location.

If the group is replaced, charts with the same name are automatically renamed in the group.

Renaming a CFC or group
1. Select the CFC or the group in the project tree.
2. Select the "Rename” command in the shortcut menu.
Alternatively, press the <F2> key.

3. Enter the new name.

Configuring CFC charts
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Deleting a CFC

Note
Checking interconnections

If you delete a CFC, interconnections to other charts are also deleted.

Before deleting a CFC, you should therefore check whether the chart has interconnections

to other charts.

The values of the respective input and output parameters are reset to the values preset

in the block type.

Correct the reset parameters if necessary.

Procedure

1. Select the CFC in the project tree.

2. Select the "Delete" command in the shortcut menu.
The CFCis deleted.

Interconnections to other charts are also deleted.

Deleting a group

See also

78

When you delete a group, you also delete all the objects it contains.

Procedure
1. Select the group in the project tree.

2. Select the "Delete" command in the shortcut menu.

Copying objects (Page 40)

Copying instructions, blocks and charts (Page|107)
Creating a CFC chart (Page 70)

Overview of textual interconnections (Page 158)

Hierarchical CFC charts (Page|31)
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4.3.6 Printing a CFC chart

Overview

Configuring CFC charts

You can print CFC charts, for example, to create documentation.

Using multiple selection, you can print several CFC charts at the same time.

In addition to the selected view, the instructions and blocks configured in the CFC chart and
their input and output parameters are also printed.

Settings

You can select different print settings for printing the CFC charts, e.g. sheet bars, number of
sheets, sheet size.

Menu bar: Basic settings for all CFC charts to be newly created

¢ "Options > Settings > Charts"

Chart properties in the Inspector window | Print settings for one or more selected CFC charts

¢ "General > Sheet bars/Layout"

Note
Taking into account format and sheet borders

If you use CFC charts without sheet bars, make sure that instructions/blocks are not placed
on sheet borders.

If the sheet size used in the CFC chart does not match the sheet size in the printer,
the CFC chart is scaled automatically when it is printed.

If you select a smaller sheet size for a CFC chart, the position of the objects in the chart
is maintained.

Objects that would be outside the sheet size after the size reduction is positioned
automatically.
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Print settings

Printer Select the desired printer from the list or via the "Advanced" button.

Document information Select the desired layout from the list.

The frame stored in the document information is used for the printout.

Print the cover page The cover page from the layout selected under "Document

information” is used.

Print table of contents The table of contents contains the structure of the CFC charts in the

navigation area.

Properties e All: Prints all project data of the selected CFC charts.

e Compact: Prints the project data in compact form.

Additional information in the information system of the TIA Portal:

"Edit project data > Print project contents > Print project documentation”

Procedure: Displaying print preview

1.

Select the CFC charts you want to print in the project tree.

2. Select the "Print preview" command in the shortcut menu.
3.
4

Select the print settings.

. Start creating the print preview by pressing the "Preview" button.

The print preview is opened in the work area.

You can also print the CFC chart from the print preview.

Procedure: Printing a CFC chart

1.

Check the chart settings:

— By using the "Options > Settings > Charts" menu command

— In the properties of the CFC chart in the Inspector window under "Sheet bars/Layout”
Select the CFC charts you want to print in the project tree.

Select the "Print" command from the shortcut menu.

Alternatively, use the keyboard shortcut <Ctrl+P>.

Select the print settings.

Start the printout with the "Print" button.

Alternative procedure: Print a group

Instead of selecting multiple CFC charts, you can also select a group and then the "Print"
command from the shortcut menu of the group.

in this case, all the CFC charts in the group are printed.

The order in which they are printed is decided by the order of the CFC charts in the
project tree.

80
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Result
The CFC chart is output on the printer.
Chart partitions are sorted alphabetically in a CFC chart.
If you have selected several CFC charts, they are printed in the order in which you
selected them.
See also

Basic settings for CFC charts (Page 43)
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4.3.7

4.3.7.1

Procedure

Result

See also

82

Limiting editing of CFC with password

Activating password for a CFC chart

To protect a CFC chart or hierarchical CFC chart from unintentional editing, you can protect
the chart with a password.

NOTICE
Password: No authorization, no know-how protection of the charts

The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
* Protection against unauthorized access to know-how in CFC charts
* Security-relevant authorization for access to CFC charts

More information:

* "Protection from unintentional access to CFC charts (Page 36)"

1. Go to the required CFC chart in the project tree.

2. To open the "Enable protection” dialog, select the menu command "Access protection” from
the shortcut menu.

Alternative procedure:
— Double-click on the CFC chart to open it.
— Select the entry "Protection” in the "Properties” tab of the inspector window.
— Click the "Protection” button.
3. Enter the desired password in both boxes.

4. Click "OK" to close the dialog box.

The password is activated for this CFC chart.

This is indicated by a small padlock symbol on the icon of the CFC chart in the project tree.

Protection from unintentional access to CFC charts (Page[36)
Changing or deactivating password for a CFC chart (Page 83)
Opening a password-protected CFC chart (Page 85)
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4.3.7.2

Procedure

Result

Configuring CFC charts

4.3 Creating and managing CFC charts

Changing or deactivating password for a CFC chart

When a password was assigned for a CFC chart, you can change or deactivate the password.

1. Go to the required CFC chart in the project tree.

2. To open the "Change protection” dialog, select the menu command "Access protection” from
the shortcut menu.

Alternative procedure:
— Double-click on the CFC chart to open it and enter the password.
— Select the entry "Protection” in the "Properties" tab of the inspector window.
— Click the "Protection” button.
3. Enter the current password in the "Old password" box.
4. Select whether you want to change or deactivate the password:
— To deactivate the password, click on the "Remove" button.

— To change the password, enter the new password in the boxes "New password" and
"Confirm password".

5. Click "OK" to close the dialog box.

The password is activated or changed for this CFC chart.

When you have deactivated the password, the small padlock symbol is no longer shown on
the icon for the CFC chart in the project tree.

NOTICE

Password: No authorization, no know-how protection of the charts

The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
¢ Protection against unauthorized access to know-how in CFC charts
* Security-relevant authorization for access to CFC charts

More information:
* "Protection from unintentional access to CFC charts (Page 36)"
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See also
Protection from unintentional access to CFC charts (Page|36)
Activating password for a CFC chart (Page 82)
Opening a password-protected CFC chart (Page 85)
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4.3.7.3 Opening a password-protected CFC chart

Requirement
¢ The password is activated in the CFC chart.

Charts with activated password are indicated by a small padlock symbol on the icon of the
CFC chart in the project tree.

Procedure
1. Go to the required CFC chart in the project tree.
2. Double-click on the CFC chart.
The "Access protection” dialog opens.
3. Enter the password and click "OK".
The CFC chart is open in the "CFC" editor.
The contents of the chart and the interface can be edited.

4. To open the CFC chart write-protected, click the "Cancel" button in the "Access protection”
dialog.

— A message is displayed in the editor window, but the contents of the chart are not
displayed.

— Editing the chart interface is possible to a limited extent.

Result
The CFC chart is opened as editable.

NOTICE

Password: No authorization, no know-how protection of the charts

The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
¢ Protection against unauthorized access to know-how in CFC charts
* Security-relevant authorization for access to CFC charts

More information:

* "Protection from unintentional access to CFC charts (Page 36)"
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See also
Protection from unintentional access to CFC charts (Page|36)
Activating password for a CFC chart (Page 82)
Changing or deactivating password for a CFC chart (Page 83)
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4.3.8 Changing the sheet bar view of a CFC chart

Layout of the sheet bars

The following sheet bar views are available:

Procedure

Static sheet bars
No sheet bars

Dynamic sheet bars

. Click in a free area of the CFC chart.

Alternative procedure

4.3 Creating and managing CFC charts

. Select the required sheet bar view under "Sheet bars/layout” in the Inspector window.

You can also change the sheet bar view using the icon in the toolbar.

Result

The sheet bar view changes.

Connectors in the sheet bars are positioned either in the sheet bar or beside the input or

output parameters on the sheet bar view you have set.

To adapt the width of fixed sheet bars to the text length of the interconnections, double-click
the boundary line of the sheet bar.

See also

CFC views (Page 66)
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4.3.9

Creating a subchart for a hierarchical CFC chart
You can create CFCs in hierarchical structures.

In doing so, you add one or more CFCs as "subcharts" into a "basic chart".

Procedure: Create a new subchart

1. Open the CFCin which you want to insert a different chart as subchart.

2. Toinsert a new CFC as subchart, click the "Insert a new subchart" icon in the toolbar of the

"CFC" editor: i

The mouse pointer transforms into an attached subchart icon.

. Click the position at which you want to insert the new subchart.

The new subchart is displayed as an icon in the opened CFC.
The changes are displayed in the "Charts" folder:

— If the CFCinto which the new subchart was inserted did not contain any subcharts, it is
now displayed as a basic chart.
— The new CFC was created automatically and is now displayed as subchart.

— The new subchart has the name of the basic chart with the suffix " _1".

Assign a meaningful name to the subchart.

4. Configure the newly created subchart.

Alternative procedure: Shortcut menu
1. In the open chart, right-click the location where you want to insert a subchart.

2. Select the "Insert a new subchart" command from the shortcut menu.

Alternative procedure: Insert existing CFC

88

1. Open the CFC in which you want to insert a different chart as subchart.

2. Drag a CFC from the project tree or a library to the open CFC in the editor.

The new subchart is displayed as an icon in the opened CFC.
The changes are displayed in the "Charts" folder:

— If the CFCinto which the new subchart was inserted did not contain any subcharts, it is
now displayed as a basic chart.

— The CFCyou inserted is copied and displayed as subchart in the tree structure of the
basic chart.

The new subchart and the CFC inserted as source can be configured independently of one
another.

When you change the original, inserted CFC and want to apply the change to the
subchart, you can replace the subchart.

Additional information: "Replacing hierarchical CFC charts (Page 90)"
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Result
You have inserted a subchart in a CFC that represents a hierarchical chart with basic and
subcharts.
In the subchart and basic chart, you can configure new parameters and create
interconnections to parameters in the chart interface.

See also

Hierarchical CFC charts (Page 31)
Create CFC chart partitions (Page|74)
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4.3.10

Use case

Requirement

Procedure

Result

90

Replacing hierarchical CFC charts
You can replace a hierarchical CFC with a different hierarchical CFC.

If possible, the interconnections of the "old" chart are retained.

Replacement can be used, for example, in situations where subcharts are configured

as sub-functions that are intended for use in different applications.

Example

You configured a sub-function as hierarchical CFC and interconnected this subchart in a CFC.

This sub-function could be a control for a ventilation system that is available in different
variants, depending on the application.

You can always interchange these variants in the overall structure without having to change
the interconnections.

The CFC that is to replace a specific subchart is available in a library in the "Charts" folder
as a basic chart, or in a different CFC.

. Open the basic chart that contains the subchart you want to replace.

. In the project tree or in a library, navigate to the CFC that is to replace the subchart.

You can also open a different CFC that contains the desired CFC.

. Drag-and-drop the CFC from the project tree, from the library, or a different CFC into the

subchart that is to be replaced.

. Release the mouse button as soon as the mouse pointer is positioned exactly over the CFC to

be replaced.

Alternatively, copy the CFC and select the "Paste” command in the shortcut menu at the
icon of the subchart to be replaced.

A dialog opens and prompts you to confirm the replacement of the CFC.

. Confirm the replacement with "Yes".

The subchart is replaced by the inserted CFC.

The name of the replaced subchart remains the same.
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See also
Hierarchical CFC charts (Page 31)
Creating a subchart for a hierarchical CFC chart (Page 88)
4.3.11 Moving subcharts to the root level
Requirement
¢ The CFC to be moved may not contain any external interconnections to the chart
interface.
Procedure
1. Select the subchart that is to be moved to the root level from the "Charts" folder of the
project tree.
2. Drag-and-drop the subchart to the root level of the "Charts" folder.
You can also copy and paste the subchart to the root level.
Result
You have successfully moved or copied the previous subchart to root level in the "Charts"
folder.
See also

Hierarchical CFC charts (Page 31)
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4.3.12 Adding, editing and sorting parameters of the chart interface

Chart interfaces

Procedure

92

Hierarchical CFC charts and standard CFC charts have an interface structure that is similar to
that of blocks.

This means that these CFC charts can be configured and interconnected externally similar to
blocks.

Interconnections with chart interface parameters are visualized using the chart sheet bar or
via connectors.

. Open the CFC chart whose interface you want to change.

The chart interface is displayed in the top area of the "Data flow" or "Control flow" section
in the "CFC" editor.

The properties of the attributes are displayed in the Inspector window.

When the "Interface" area is hidden, enlarge the area with the mouse or click the unhide
icon:

i s |

. If you want to add a new parameter, click the "<add>" line in the "Name" column in the

required Input, Output or InOut section.
The new parameter is added in the selected line.
The "Name" field is opened for editing.

To add a line, select the item "Insert line" or "Add line" from the shortcut menu of the line.

3. Enter the name of the new parameter.

. Select the desired data type in the "Data type" column.

All CFC data types are supported in the chart interface except:
— TIMER
— COUNTER

— Hardware data types

. If necessary, change the other attributes of this parameter, for example, "Value" or

"Configurable".

. If you wish to change a parameter, click the required field in the table line.

Depending on the type of field, it is opened for editing or a drop-down list is displayed.
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7. To change the sequence of parameters in the table, drag the name of the parameter or the
line to the new position.

You can only change the sorting within a section, for example, the parameters in the
section "Input”.

8. If you wish to delete a parameter, select the name of the required parameter.
Select the "Delete" command in the shortcut menu.

The line of this parameter is removed from the table.

Result
A parameter was added, edited or deleted in the chart interface.

The sorting of the parameters was changed, if necessary.

See also
Hierarchical CFC charts (Page 31)
Interconnections to parameters of the chart interface (Page 144)

Data types in CFC (Page|209)
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4.4

4.4.1

Overview

Adding and managing objects in the CFC chart

Representation of instructions and blocks

The following section contains information related to instructions/blocks in the CFC chart:
* Block icon: visualization, layout, editing options
* Block interface: layout, editing options

» Additional information at the block icon: For example, display of run sequence, processing
display, display of hidden parameters

* View in the CFC chart: Zoom function, signal flow

Note
Use of the terms "instruction” and "block"

The following description applies to both instructions and blocks.

For simplification, however, we only use the term "block”, for example, "block header".

Representation of the block icon

94

An instruction or a block is represented as a symbol in the CFC chart.
The following options are available for the representation:

* You cannot change the representation of the block icon in the case of instructions from
the "Instructions" task card.

e For blocks, several options are available for the representation of the block icon in the CFC
chart.

More information: "Representation options for the block icon in the CFC chart (Page 102)"
Additional icons are used for representation of the basic and subcharts.

More information: "Hierarchical CFC charts (Page 31)"
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Structure of the block icon

In principle, the block icon in the CFC chart consists of the so-called block header and the
block interface.

However, this is not true for the smallest representation option "Builtin;SmallBlock" of the

block icons.
Cyclic interrupt_2 :_ 2
@2 myfb_2 2 ]
’ MyFB_2 —®
Block used for testing |
input_BOOL output_1—}—
1 —input_INT output 2— 2
——INOUT_1 il |
A A

) Block header

(2) Block interface

3) Display for hidden parameters

(4) Processing display

(5) Run sequence: Position number, assigned task (optional display)
Change size

* You can change the width as required.

¢ The height of the icon depends on the number of input and output parameters.

To change the height of the icon, show or hide the input and output parameters.
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Block header (1)

96

The block header can display the following information:

Instance name (e.g. "myblock_1 1"
Type name (e.g. "MyBlock _1")
Instance comment

Processing display

The information shown in the block header depends on the instruction or block and the
target system you are using.

With some types of instructions and blocks, the block header may be missing altogether or
simply contain a small icon, for example, an instruction for an OR logic operation.

=

Bt

Editing options in the block header

In the work area, you have the following options for editing the block header:

Changing the instance name and instance comment

Selecting a block/instruction

Configuring CFC charts
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Block interface (2)
The block interface displays the input and output parameters:
e Left: Input parameters
¢ Right: Output parameters
Normally, the block parameters have the parameter values of the type by default.
The name of the input and output parameter is displayed in full length or truncated
depending on the width of the symbol.
Comments of the block type
You can show the comments instead of the names of the input and output parameters.

To toggle between names and comments, use the following button in the toolbar:

Parameter: Tooltips

When you hover your mouse over an input or output parameter, a tooltip with the following
information is displayed:

¢ Name of the parameter

¢ Data type of the parameter

¢ Comment of the parameter

When you expand the tooltip, the following information is displayed:
¢ Value of the parameter

e Parameter section

Editing options in the block interface

In the work area, you have the following options for editing the block interface:
e Set the parameters of the input and output parameters.

¢ Interconnect the input and output parameters using drag-and-drop.

¢ Select the input and output parameters.

¢ Selecting a block/instruction

Navigation with the keyboard

¢ To select individual parameters with the keyboard, click on the block and press the
<Down> arrow key:

* Use the <Right> and <Left> arrow keys to switch between the parameters: [,
* Use the <Up> arrow key to return to the block level:

¢ When the entire block is selected, use the <Right> and <Left> arrow keys to switch
between the blocks.
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Display for hidden parameters (3)

The icon indicates that the "Invisible" property of the parameter is activated.

If input or output parameters are set to "invisible" and are therefore hidden in the block icon,
this fact is indicated by an additional triangle symbol at the bottom of the icon.

Icon Meaning
5 A non-interconnected parameter is hidden.
i An interconnected parameter is hidden.

More information: "Hiding input and output parameters (Page/151)"

Processing display (4)

98

The processing display at the top left corner of the block header indicates whether the block
is processed in the program sequence.

If the block header is missing, for example in the case of instructions, the processing display
is shown at the block interface.

The processing of a block depends on the following elements:
e Enable input "EN" at the block
e "Enable chart" option of the CFC chart in which the block is added

The display shows the following states:

Icon Meaning

No symbol | Block is always processed.

7 Block is processed conditionally.

The reason is that the enable input "EN" at the block or the "Enable chart" option of the
chart has been interconnected.

“ Block is not processed.
The reason is that the enable input "EN" at the block is "FALSE" or the "Enable chart"

option of the chart has been disabled.
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Additional information at the block icon

Mouse pointer

The change in the mouse pointer over the instruction or block icon indicates the various
editing options available, for example, moving or selecting.

Tooltip

When you hover your mouse over the block icon, a tooltip with the following information is
displayed:

Instance name
Type name
Task

Comment

If the instance has no comment, the comment of the type is displayed.

Display of the run sequence (5)

Using the toolbar of the data flow, you can show the position of the instruction or block in
the run sequence.

Icon Meaning

The position number in the run sequence is displayed above the block header.

The name of the assigned task is displayed above the block header.

For subcharts, information that the task was inherited from the basic chart is added
where appropriate.

i N
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Data flow: Zoom function
You can set the zoom ratio and customize the size of the view in the CFC chart using the data
flow toolbar functions.
Zooming in on multiple objects

If you select multiple objects in the CFC chart and then run the "Zoom in" or "Zoom out"
function, the view is zoomed automatically to the center of the selected objects in the work
area.

The objects may also extend to other sheets.

Input boxes: Response to zooming

When you increase the zoom factor for the view of the CFC chart to over 100%, the input
boxes in the chart and in the sheet bar are also zoomed in on. At 200%, input boxes in the
sheet bar are enlarged up to the edge of the area.

The text size in the input box is not affected by the zoom factor. The larger input boxes
therefore allow convenient editing of even long interconnection paths.

Highlighting for signal flow
You can highlight the flow of signals in the CFC chart.

The signal is highlighted starting from the selected block or subchart, ending at the /O of the
signal in the sheet bar of the CFC chart. All relevant interconnections and blocks are marked
in color here.

The signal is highlighted only within the CFC chart, but not in other charts.
The signal flow is only displayed when a block or subchart is selected.

The function is enabled using the "Highlight signal flow" toolbar icon: I

Example

The following figure shows an example of the highlighted signal flow for an interconnection
of type "BOOL". The example in this figure shows a chart section with three instructions.

The arrow marks the click position for the "AND" instruction.

The highlighting is continued to the left and right of the click position up to the chart
boundaries because all three instructions are involved in the signal flow.

—.

8
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See also
Representation and properties of interconnections (Page|127)
Placing instructions and blocks in the CFC chart (Page|105)
Adding an instruction or block to the CFC chart (Page 109)
Setting the parameters of the input and output parameters (Page|123)
Adapting the run sequence within the CFC chart (Page 171)
CFC naming conventions (Page/41)

Options for determining the run sequence (Page|168)
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44.2 Representation options for the block icon in the CFC chart

Overview

Basic procedure

102

You specify the representation of the block icon in the CFC chart with an attribute at the
block type.

There are multiple options for displaying the block instances.

Note
Block instances

The configured representation option at the block type cannot be changed for specific
instances.

Changing the representation option at the type affects all instances.
Instructions

You cannot change the representation option for instructions from the "Instructions" task
card.

You specify the size of the block icon in the CFC chart in the properties of the type with the
attribute "Block representation™:

1. Open the properties via the shortcut menu of the block type.
2. Inthe "General" tab, select the "Attributes” item.

3. Enter the required representation option in the "Block representation” field in the "User-
defined attributes" area.

Use the following syntax for this:

Large BuiltIn;Block

Medium BuiltIn;MediumBlock
Medium / narrow BuiltIn;NarrowMediumBlock
Small BuiltIn;SmallBlock

4. Save and compile the changed block.

If you wish to use the changed block as type in a library, copy the changed block into the
respective library.

5. Update the instances of this type in CFC.
Additional information: "Updating instances of a changed block type (Page[120)"
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Representation options for the block icon

Configuring CFC charts

The table shows the various representation options.

The same block is displayed in the "Example" column in the corresponding representation

option.

Representation option/syntax

Example

"Large" version

B22.1
Syntax: L
e BuiltIn;Block all datatypes
. . . . . . —Input_1 Output_1—
The block icon is displayed in full size in the CFC —lnput_2 Output_2—
chart with all details in the block header and —Input_3 Output_3—
block interface. —Input_4 Dutput_4—
—Ilnput 5 Output_5—
—Ilnput_& Output_t&—
—Input_? Output_7—
—Ilnput_g Output_5—
—Input_2 Output_9—
—Ilnput_10 Output_10—
—Input_11 Output_11—
—Ilnput_12 Output_12—
—Ilnput_13 Output_13—
—Input_14 Output_14—
—Input_13 Output_15—
"Medium" version
S . E22_1
yntax. —Ilnput... Outp..
e BuiltIn;MediumBlock — Dl
. L X . . —Input.. Outp..
The block icon is displayed in medium size in the —Input... Outp...
CFC chart. —Input... Outp...
. . . . —Ilnput... Outp..
The block header is reduced in size and displays W=
only the block name. —Input.. Outp...
The parameter names in the symbol are —::Eﬁ SE:E
gjlsplayed in abbreviated form in the block inpit.. Outp..
interface. input.. Outp..
The complete parameter name is displayed as a —:nput.. gutp...
tooltip. — e
P —Ilnput... Outp..
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See also

104

Representation option/syntax

Example

"Medium/narrow" version
Syntax:

e BuiltIn;NarrowMediumBlock

This version corresponds to the "Medium" version
in the representation of block header and
interface.

The width of the block icon is also reduced.

B22_1
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...
—Ihp... Ou...

"Small" version
Syntax:

¢ BuiltIn;SmallBlock
The block icon is displayed in the smallest size.
The block header is hidden.

The parameter names in the block interface are
only displayed as tooltip.

Representation of instructions and blocks (Page 94)

Configuring CFC charts
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443 Placing instructions and blocks in the CFC chart

Adding instructions and blocks

The positioning of instructions/blocks on the sheet of a CFC chart depends on whether you
are working in "data flow" or "control flow" tab.

¢ Data flow:
Position the inserted object by dragging it with the mouse.
¢ Control flow:

The inserted object is automatically placed at a free location in the CFC chart.

Automatic placing of instructions/blocks

Objects, such as instructions/blocks, are positioned automatically in "data flow" mode under
the following conditions:

* You add the object in the control flow.
* You add instructions to the CFC chart by double-clicking in the library.
* You enable automatic positioning in the shortcut menu of the object.

If the location of an automatically placed object is occupied by another object, then this
object is moved automatically to a free location.

The property "Position automatically" is set at the properties of an object.

The following figure shows two instructions; automatic positioning is enabled for the
instruction on the left.

The automatically positioned instruction has a colored border:
—& T _&”
[ ]
You disable automatic positioning of an object as follows:
¢ You disable automatic positioning using the shortcut menu.

¢ You move the object.

Positioning objects in the CFC chart according to the data flow

Use the function "Place blocks according to the data flow" to place the objects in the CFC
chart, e.g. blocks and instructions, according to the data flow.

This option makes for clearer positioning of objects and data flow as well as easier signal
tracking.

The function is executed only manually in the open CFC chart and you cannot enable it
permanently.

Additional information: "Positioning objects according to the data flow (Page 113)"

Configuring CFC charts
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Instructions/blocks that cannot be fully displayed

See also

106

Under the following conditions, objects such as instructions/blocks are displayed without
interconnections and in a different color:

¢ Automatic placing: There is not enough space for all objects on the sheet of a CFC chart.

¢ Manual placing: You position objects on top of each other, on an interconnection or on a
sheet border.

Interconnections to objects that cannot be fully displayed are shown as connectors.

If objects are located on top of each other, the lowest object is shown completely. All objects
above it are shown incompletely.

The following figure shows an instruction located on the sheet bar.

The interconnection between the two instructions is displayed as a connector in the sheet
bar:

and_18.0UT 14 &~

Representation and properties of interconnections (Page|127)
Adding an instruction or block to the CFC chart (Page/109)
Deleting an instruction or block from the CFC chart (Page 114)
Aligning objects in a CFC chart (Page|[112)
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444 Copying instructions, blocks and charts

Blocks with interconnections to external tags

Configuring CFC charts

If you interconnect an input or output parameter with an external tag, a connector is created.
The connector has the name of the external tag.

If you copy an instruction or a block with an interconnection to an external tag, the connector
is also copied.

The name of the tag will remain the same in the copy of the connector.

Check the interconnection with the external tag in the copy and change the name, if
necessary.

AWARNING

Check the user program before using it

Despite a valid criteria check, the algorithm can be different in the instructions or blocks.

To avoid possible errors in the plant, check the code of the user program in the instruction
or block if you are uncertain.
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Copying CFCs

See also
Copying objects (Page 40)
Interconnecting the input and output parameters with an external tag (Page| 146)
Overview of textual interconnections (Page 158)
Configuring CFC charts
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If you copy a chart, an instruction or a block across devices or projects, then the following

conditions will apply:

Condition

Resulting action

The block that is to be copied
is missing in the target system.

The block is copied completely, including all necessary called
blocks, to the "Program blocks" folder.

At the same time, the block is imported as type into the CFC
of the target system.

The block / type that is to be
copied differs only in the

block numbering in source and
target system.

The CFCis copied to the target system. The type remains the
same in the target system. The copied CFCs in the target system
is adapted.

A type, instruction or block with
the same name already exists
in the target system.

The two instructions/blocks are compared based on their input
and output parameters and the following criteria:

e Quantity
* Name

¢ Data type
e Section

e Order

The copy function will only be performed if all the criteria match.
Otherwise, the copy function is canceled.

The task of the CFC to be copied
does not exist in the
target system.

The CFCis not copied to the target system.

Special considerations for the S7 target system

The CFCis copied to the target system. The assignment of the
CFC to the task is retained. A non-existent task is created during

the next compilation of the software, if the target system
supports this task.
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445 Adding an instruction or block to the CFC chart

For configuration of a CFC chart insert the instructions or blocks to the chart and configure
interconnections and parameters.

Requirement
e A CFCchartis open.

¢ The "Instructions” or "Libraries" task card is open.

Procedure
1. Navigate to the storage location of the selected instruction or block.
Possible storage locations:
“Instructions” task card
— Library
"Program blocks" folder in the project tree
2. Drag-and-drop the instruction or block to the CFC chart.

3. Place the instruction or block at the desired location in the CFC chart.

Alternative procedure
You can insert one or more existing blocks using copy and paste:
* Keyboard shortcuts <Ctrl+C> and <Ctrl+V>
Blocks copied in are placed at an offset over the blocks that serve as the copy source.
¢ Shortcut menu: "Copy" and "Paste" entries

The position of the mouse pointer when selecting the "Paste" entry determines where the
blocks are inserted.

Configuring CFC charts
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Result

The instruction or block is inserted into the CFC chart.

Note
Inserting a deleted instance again

Before you insert the deleted instance of a block type again, transfer the change to the
controller via a full download or 2x download of changes.

This prevents name conflicts during download.

Additional information: "Deleting an instruction or block from the CFC chart (Page 114)"

See also
Interconnecting input and output parameters (Page|136)
Adapting the run sequence within the CFC chart (Page|171)
Representation and properties of interconnections (Page|127)
Deleting an instruction or block from the CFC chart (Page|114)
Type and instance (Page|29)
Updating instances of a changed block type (Page|120)
"CFC" Editor (Page 45)

Configuring CFC charts
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4.4.6 Adding a text box to a CFC chart

Overview
To document the function of the CFC, add texts and images to the CFC:
* You can use texts, for example, to document the signal path.

¢ With an image, you can, for example, represent the part of the plant that is processed by
the CFC.

Use the text boxes to add texts and images to the CFC.

Text boxes can be located in the foreground or background of the CFC and can contain text
as well as a background image.

Text boxes in the background are ignored by blocks, instructions and interconnections.

Requirement
¢ ACFCisopen.
¢ "Data flow" is displayed.

Procedure
1. Click "Insert text box" in the toolbar.

2. Keep the mouse button pressed to move the text box to the required position in the CFC and
adjust it in size.

3. Select the "Text box in background" option under "General" in the Inspector window.

4. Todisplay a graphic, select the "Use background image" option under "General".
Select the graphic in the file selection dialog.

5. If necessary, enter the "text" for the text box.

6. If necessary, you can set additional properties of the text box in the Inspector window, such
as border, font or font size.

See also

Aligning objects in a CFC chart (Page 112)
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4.4.7

Alignment

Requirement

Procedure

Result

See also

112

Aligning objects in a CFC chart

You can align objects, such as instructions, blocks and text boxes, in the CFC or distribute
them evenly.

First, select the required objects.

The reference object on which the other objects will orient themselves is decided
automatically within the selection.

The following criteria apply:

Align

The selected objects are aligned with each other.

The object used as the reference is the furthest object in the required alignment direction.
Example: If you want to right align the edges of three objects, the objects are aligned with
the object located furthest right.

Distributing

The selected objects are distributed evenly.

The reference value used is the average position value of all the objects included in the
selection.

e ACFCisopen.
* "Data flow" is displayed.
* Multiple objects have been added.

1. Select the objects in the chart.

2. Select the command you require under "Align" in the shortcut menu of the selection.

The selected objects are aligned or distributed evenly depending on the command you select.

Adding an instruction or block to the CFC chart (Page/109)
Adding a text box to a CFC chart (Page 111)
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4.4.8

Overview

Response

Requirement

Procedure

Result

Configuring CFC charts

4.4 Adding and managing objects in the CFC chart

Positioning objects according to the data flow

When you configure a CFC, objects, such as instructions, blocks and text boxes, are added,
positioned and interconnected one after the other.

The representation of the chart can get confusing when you have a large number of objects
and interconnections.

Use the function "Place blocks according to the data flow" to place the objects in the CFC, e.qg.
blocks and instructions, according to the data flow.

This option makes for clearer positioning of objects and data flow as well as easier signal
tracking.

* The objects in the CFC are sorted automatically in columns one below the other and
aligned on a mutual axis in the columns.

The width of a column is determined by the widest object in the column.

¢ Independent subnets are listed one after the other and have columns independent of one
another.

¢ Each object is placed automatically in the chart this way so that it does not intersect the
sheet bar or other objects.

¢ For all objects that do not take part in the data flow, e.g. text boxes, the property "Position
automatically” is selected.

The function is executed only manually in the open CFC and you cannot enable it
permanently.

¢ ACFCisopen.
¢ "Data flow" is displayed.
¢ Multiple objects have been added.

1. In the toolbar select the symbol "Place blocks according to the data flow": &
The selected objects are aligned automatically.

2. Use the "Undo" button in the toolbar to undo this change.

The objects in the CFC are sorted according to the data flow.
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4.4.9

Deleting an instruction or block from the CFC chart

You can delete instances of instructions and block types in a CFC chart.

Note
Checking interconnections

If you delete an instruction or a block with interconnections, the interconnections are also
deleted.

Before deleting an instruction or block, you should check whether the chart has
interconnections.

The values of the respective input and output parameters are reset to the values preset in the
block type.

Correct the reset parameters if necessary.

Deleting instances in the device

Requirement

Procedure

114

When you insert a new instance of the same block type in the CFC chart after deleting an
instance, this instance is given the same name as the deleted instance.

As long as the deleted instance is still in the controller, this leads to a conflict during
download.

To restore consistency, perform one of the following actions:
* Full download
e 2x consecutive downloads of changes

After the first download of changes, the instance in the device may still not have been
fully deleted.

¢ The CFCchartis open.

¢ An instruction or block has been created.

1. Select the instruction or block.
2. Select the "Delete" command in the shortcut menu.
3. Start either a full download or two consecutive downloads of changes.

This also deletes the instance in the device.

Configuring CFC charts
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Result

The instruction or block is deleted.

All incoming and outgoing interconnections are also deleted.

As default, the affected input and output parameters are assigned the values of the type.
See also

Adding an instruction or block to the CFC chart (Page|[109)

Configuring CFC charts
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4.4.10 Central change of a block type

Overview
A block type is a reusable, pre-defined function.
You can create your own block type or use a block type from a library.
You create an instance by inserting a block type into a CFC chart.

The advantage of this type-instance concept is that any change of the block type can be
implemented at all instances.

Changing the block type

If the interface, the system attributes or the algorithm is changed at a block type, then an
update of the instances in the CFC charts becomes necessary.

To this end, the changed block is added to a CFC chart.

All instances of this block are also changed in all CFC charts of this target system so that they
match the new block.

Options for block change
You can change the following blocks:
* Self-created block type in the "Program blocks" folder in the project tree

* Provided block type in a library

ACAUTION

Interface change can result in full download

After interface changes at the block type and subsequent update of the block type in the
target system, you will often only be able to compile and load the entire software.

An interface change is, for example, the change of the parameter data type.

Loading of the entire software with the S7 target system requires a CPU stop.
Effects of the block change

Note the effects on the instances with every change.
Do not change internal CFC blocks

CFC creates system blocks that are displayed in a number of views or lists, for example,
under "Program information”.

You may not change these objects.

Only edit your own blocks and instructions using the STEP 7 editors.

Configuring CFC charts
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Note
“Instructions” task card

You cannot change block types in the "Instructions" task card because they are an integral
part of CFC.

Updating the instances

To update the instances after a block type change, you will have to import the new version of
the block type into the CFC.

You have the following options to do this:
¢ Blocks from a library:
Adding the changed block type to a CFC chart
¢ Blocks from the "Program blocks" folder:
— Adding the changed block from the "Program blocks" folder

— Use the "Chart sequence & extras" editor in the "Block types” tab (depending on the
target system)

Before the changed block type is imported, the block versions are compared.
The differences are displayed in the "Update blocks" dialog.

An icon in the last column indicates whether or not the change requires a download of the
software.

Additional information: "Updating instances of a changed block type (Page|120)"

Effects on the instances

Note
Checking the effects

When you update an instance after a central block type change, all other block instances in
the CFC charts of the CPU are changed automatically.

This also applies to instances in password protected CFC charts.

Therefore, check the effects in the instances before you perform the update.

Block name
Changing the block name does not affect existing instances.
Only the name of the block type is changed in the "Type data" area of the instance properties.

The instance name in the "Instance data" area is not changed.

Configuring CFC charts
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Comments

Comments are usually overwritten at the instances.

However, comments that were changed for specific instances are not overwritten.

Parameter

Examples of typical changes to block type parameters:

Change to the block type

Effect

Parameter is added

This change takes effect in the instances.
The system attributes are set to default values.

Check and update the parameter assignment or interconnection of the
new parameter at the instances.

The interconnections are hidden when the block instance becomes too
large for display in the CFC chart due to an increase in the size of the
block type.

If necessary, move the instance so that it is displayed completely in the
chart.

Parameter was deleted

The parameter is deleted in the instances.
If the parameter is interconnected, the interconnection is also deleted.

After the deletion, check the parameter assignment at the
interconnection partner.

Changed data type of a
parameter

The behavior corresponds to deleting and creating a new parameter.

Changed parameter name

The system cannot automatically make a connection to the old name.
This happens when you delete a parameter and create a new one.

Changed sequence of
parameters

The sequence of parameters is taken into account.

The interconnection, the parameter assignment, and the attributes are
retained.

However, moving two subsequent parameters with the same data type
only corresponds to renaming the two parameters. It does not include
the interconnection of the parameters.

Configuring CFC charts
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Values, comments and system attributes of the parameters
Effect of attribute changes:

¢ Changes that cannot be made for a specific instance are made automatically at the
instances.

¢ Instance-specific values, comments, and system attributes are usually overwritten.

However, values, comments or system attributes that were changed for specific instances
are not overwritten.

The table shows examples of deviations from this rule:

Change to the block type Effect

The "Configurable" attribute | The "Configurable" attribute cannot be changed for specific instances.

is deleted. The change has an effect on all instances:
e Existing parameter assignments of the input or output parameter
are maintained.
The "Interconnectable” The "Interconnectable" attribute cannot be changed for specific
attribute is deleted. instances.
The change has an effect on all instances:
e Existing interconnections are deleted.
The "Low limit" and "High "Low limit" and "High limit" cannot be changed for specific instances.

limit" attributes are

: The change has an effect on all instances:
configured.

¢ When an existing parameter value exceeds a limit value in the
instance, the parameter value is set to the default value of the
block.

See also
Type and instance (Page|29)
Creating a block type for CFC (Page 122)
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4.4.11 Updating instances of a changed block type

Overview
Blocks added in the CFC chart represent an instance of a block type.

The block type exists, for example, in a library or in the "Program blocks" folder of the project
tree.

After changing a block type, you can update the instances of this block in all CFC charts of a
target system.

Additional information: "Type and instance (Page|29)"

ACAUTION

Interface change can result in full download

After interface changes at the block type and subsequent update of the block type in the
target system, you will often only be able to compile and load the entire software.

An interface change is, for example, the change of a default value.

Loading of the entire software with the S7 target system requires a CPU stop.
Effects of the block change

Note the effects of the change on the updated instances.

Additional information: "Central change of a block type (Page/116)"

Requirement
e A CFCchartis open.

¢ The changed block type exists in a library, for example.

Configuring CFC charts
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Procedure

1. Select the changed block type in a library or in the project tree in the "Program blocks"
folder.

2. Drag the symbol in the CFC chart.

If at least one instance of the block is used in a CFC chart of the CPU, the "Update blocks"
dialog is displayed.

— The changes and their effects are listed.

— Anicon in the last column indicates whether or not the change requires a download of
the software:

i# No download necessary *)
i Download of the software required
= Download with CPU Stop required

*) Regardless of CFC, changed blocks may be downloaded by STEP 7 into the
controller.

3. To update the instances, click "OK".

The block instances are updated in all CFC charts of the same target system to the
changed version.

If necessary, change the interconnections at the instances.

S7 target systems: Alternative procedure

You can also update block types in the "Program blocks" folder in the "Block types" tab of the
"Chart sequence & extras" editor.

The functionality in this tab is specific to the target system.

Additional information: "Working with CFC charts for S7 > Updating block type imported in
CFC"

Result

The instances of a changed block type are updated in all CFC charts of the target system.

Configuring CFC charts
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4412 Creating a block type for CFC
Complex functions can be combined and reused in a block in the type-instance concept.

You can define a block you have created yourself as a type and save it in the project library or
a global library.

Requirement
e The "Libraries" task card is displayed.

* You have created a block in the project tree.

Procedure

1. Select the pane with the library in the "Libraries" task card in which you want to define a
block type:

— The "Global libraries" pane for the required global library
— The "Project library" pane

2. Click the "Master copies" folder in the selected library.
Any existing subfolders are displayed.

You can create a new subfolder, if necessary, in the shortcut menu with the "Add folder"
command.

3. Copy the required block with drag-and-drop to the intended position in the "Master copies"
folder.

The shape of the mouse indicates where you can add the block.

Result
A new block type has been defined in the project library or in a global library.

You can create instances of this block type and use them in CFCs.

See also
Type and instance (Page|29)
Central change of a block type (Page 116)
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4.5 Configuration and interconnection of input and
output parameters

4.5.1 Setting the parameters of the input and output parameters

Overview

If you add an instruction from the "Instructions” task card or a block from a library to a CFC,
then the parameters are assigned with the values of this object type by default.

Values that were changed at the type are passed to the instance in the CFC the next time a
type import is performed.

If you assign parameter values to the input or output parameters, passing on the parameter
value from the type to the instance is interrupted.

You can re-enable the passing on of these values at any time in the Inspector window. The
assigned parameter value is then once again replaced by the default value of the type.

When you assign a parameter value, the entered value is checked for plausibility and syntax
depending on the data type.

Requirement

¢ ACFCisopen.

¢ "Data flow" is displayed.

¢ Aninstruction or block has been added.
Procedure

1. Select the required input or output parameter in the CFC.
2. Enter a value for the input or output parameter in the "Value" field of the Inspector window.
This stops the value from being passed on by the type of this instruction or block.

If the values for "Low limit" and "High limit" are configured at the type, these limits are
taken into consideration when you make an entry in the "Value" field.

3. If necessary, enter a measurement unit in the "Unit" field or select a unit from the list.
If a unit is assigned at the type, this unit is passed on to the instance.

You can disable this process by making an entry or selecting from the list.

Alternative procedure
As an alternative, you can set the input or output parameters directly in the CFC.

If you need to set many parameters for the input or output parameters, use the "control flow"
mode.
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Result
The input or output parameter has been assigned.

When you download the CFC to the device, the input or output parameter has the assigned
value as default.

Configuring CFC charts
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45.2 Pre-assignment of attributes for input and output parameters

Attributes at the block type

You can configure the attributes of an input or output parameter at each instance of a block.

It is also possible to pre-assign the attributes of an input or output parameter at the block
type.

These pre-assigned values are passed on at an instance of this type.

You can either accept this pre-assignment or, if necessary, change it for specific instances.

These attributes include, for example:

Basic procedure

Configuring CFC charts

Can be changed for specific instances:

— Comments

— Attributes, e.g., "Value", "Unit", "Invisible", "For test"

Cannot be changed:

— e.g. the attributes "Configurable", "Interconnectable" "Low limit", High limit"

. Open the block used as type, for example, in the "Program blocks" folder of the project

navigation.
Select the required input or output parameter in the interface.

The "General" tab is displayed in the Inspector window.

. Under "Attributes”, make the required settings to be passed on as pre-assignment to the

associated instances.

. Save and compile the changed block.

If you wish to use the changed block as type in a library, copy the changed block into the
respective library.

. Update the instances of this type in the CFC.

Additional information: "Updating instances of a changed block type (Page 120)"
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Display and update at the instance

If the input or output parameter is selected, the pre-assigned values are displayed in the
"Type data" column under "General" in the Inspector window.

The pre-assignments for values and functions configured in the type are passed on to the
instance.

You can make your own configurations in the instance, e.g., enter start values, select units.
This stops the respective value from being passed on by the block type.

The following symbols display the status:

Icon Meaning

The value is passed on from the type to the instance.

The value is not passed on from the type to the instance because it was changed
at the instance.

You can re-enable the passing on by clicking on this symbol.

Updating instance

Instance-specific changes are not automatically overwritten when the type is updated.

Notes: "Low limit" and "High limit"

126

The low limit and high limit values are displayed after the data type as additional information
at the parameter of the block instance in the "Type data" column of the "Type" field.

"Low limit" and "High limit" cannot be changed for specific instances.

These two values have an effect on all instances when the type is updated:

If an existing parameter value exceeds a limit value, the parameter value is set to the default
value of the type and a log entry is made.

Example

e Datatype =INT

e Lowlimit=10

* High limit=90

Display in the "Type" field:

e Int (10..90)

Configuring CFC charts
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45.3 Representation and properties of interconnections

Routing of an interconnection

When configuring interconnections, you only specify which output parameter is
interconnected with which input parameter.

The routing of the interconnection is handled by the editor. Other objects in the CFC chart are
automatically avoided.

If you move interconnected instructions or blocks in the CFC chart, the routing of the
interconnections is adapted automatically.

The following figure shows the routing of an interconnection around a third object:

CMP_OI
—IN1 GT—
—IN2 GE—

EQ—
| LE— |

If you have marked text boxes as being in the "background”, these are ignored by the routing.

Interconnection options
The following options are possible for interconnections:
* From one output parameter to one or several input parameters
* From one input or output parameter to one external tag

An overview of the points of use of interconnected tags and global data blocks can be
found in the "Tag interconnections" tab of the "Chart sequence & extras" editor.

¢ Several options are available for input and output parameters of STRUCT data type.

More information: "Interconnections with structures as input and output parameters
(Page 133)"

Note

Interconnections to constants are not possible.

Configuring CFC charts
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Interconnection

Interconnection

128

Interconnections from one output parameter to several input parameters
You can use the value of an output parameter as the value for several input parameters.
You need a multiple interconnection for this purpose.

An interconnection node is inserted for each branch to an input parameter. An
interconnection node corresponds to an interconnection at the output parameter.

If you drag an interconnection node to an output parameter, all interconnections leaving the
interconnection node is interconnected to this output parameter.

The following figure shows an interconnection from one output parameter to two input
parameters with one interconnection node:
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that cannot be fully displayed

Every object and every interconnection requires space in the CFC chart. If interconnections
cannot be displayed fully, the editor automatically uses connectors.

The following figure shows an interconnection between two AND logic operations that
cannot be displayed completely:
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The interconnection is represented by connectors with the same numbers.
If there are multiple connectors, the numbers are incremented continuously.

To jump between connectors in the view, double-click the respective connector.

beyond sheet borders

If you interconnect instructions or blocks beyond sheet borders, the interconnection leads as
far as the sheet bar of the sheet.

A connector is inserted in the sheet bar. The connector has the name of the target object and
the parameter.

If the destination of an interconnection is located in a different CFC chart, the name of the
CFC chart is also displayed. When the CFC chart contains multiple chart partitions, the chart
partition name and the sheet number are also displayed.

Configuring CFC charts
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Color display
The color of the connector shows the type of interconnection.
¢ Connector color "Light beige":
The selected target connector is displayed in the sheet bar.
¢ Connector color "Dark beige":
The selected target connector is displayed in the extended sheet bar.
Connectors 1 to 8 are shown in the following figure at the different output parameters.
¢ Connectors "1" to "5" as well as "7" are "light beige".
This means the selected target connector is displayed in the sheet bar.
e Connectors "6" and "8" are "dark beige".

This means the selected target connector is displayed in the extended sheet bar.
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Navigation beyond sheet borders

When you double-click on a connector or sheet bar entry, the destination of the
interconnection is displayed centered in the work area.

To jump back, select the "Back" command in the shortcut menu of the chart.

To continue configuration, use "Back” to switch between the last two positions.

Display in the sheet bar view

The following figure shows an interconnection between two instructions on different sheets
of a CFC chart with the sheet bars enabled.
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If the sheet bar view is disabled, the following rules apply to interconnections between sheets
or between charts:

* Between sheets:
The interconnection is displayed normally on one sheet.
* Between charts:

The connector is placed next to the parameter.

Placing a connector manually

In a chart with disabled sheet bar view, you can manually move connectors between sheets
and between charts:

* Automatic placing of the moved connector is disabled.
The connector remains in this position, regardless of the associated instruction position.

* To reenable automatic positioning, select the "Position automatically" option from the
shortcut menu of the connector.
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Signal tracking for interconnections

If you click on an interconnection or a connector, the interconnection is highlighted in color.
The mouse pointer changes and is shown as "Interconnection cursor".

If output parameters have several interconnections, which interconnection is highlighted
depends on where you click. Depending on the position of the click, either all
interconnections or only some of them are highlighted.

You have the following options to track a signal for an interconnection across sheets:

¢ Asingle click on the connector at the parameter of the block or instruction displays the
associated connector in the sheet bar or the extended sheet bar.

¢ If you double-click on a connector in the sheet bar, then the destination of the
interconnection is displayed in the work area.

Depending on the position of the interconnection target, the respective sheet of the same
CFC chart or chart partition is displayed or the respective CFC chart opened.

To jump back or to switch between positions, select the "Back" command in the shortcut
menu of the chart.

For navigation between the chart partitions, also use the drop-down list or the keyboard
shortcuts <Shift+PgUp> and <Shift+PgDn>.
Example

The following figure shows an output parameter with multiple interconnections of a sheet-
internal interconnection.

The arrow shows the click position and the resultant color highlighting.
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Color of connection lines depends on the data type

See also

132

The interconnection lines in the "Data flow" view of the CFC chart are displayed in different
colors depending on the data type.

The assignment of the data type and color can be changed.
The data type of the data source determines the shown color.

For interconnections to operands whose data type is not defined, the default value "black" is
used.

More information: "Changing the color of interconnection lines (Page/135)"

Displaying points of use of interconnections (Page|153)

CFC views (Page 66)

Placing instructions and blocks in the CFC chart (Page|105)

Interconnecting input and output parameters (Page|136)

Working with multiple interconnections (Page|141)

Changing an interconnection (Page|155)

Changing the color of interconnection lines (Page| 135)

Deleting an interconnection (Page|157)

Adding or removing input parameters (Page 148)

Hiding input and output parameters (Page/151)

Interconnecting the input and output parameters with an external tag (Page|146)
Interconnections with structures as input and output parameters (Page[133)
Negating input parameters (Page|150)

TERMINAL: Summary of interconnections (Page 289)
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4.5.4 Interconnections with structures as input and output parameters

Interconnecting structures and structure elements

In CFC, it is possible to interconnect the input or output parameters of the STRUCT data type
as a complete structure.

However, you can also interconnect individual structure elements of a parameter of the
STRUCT data type.

Structure elements can be of an elementary data type or "STRUCT in STRUCT".

Note
Configuration depending on the target system

Interconnection of structures and their elements depends on the target system.
Target system S7: Interconnection with the chart interface

The individual structure elements cannot be interconnected for a parameter of the STRUCT
type in the chart interface.

Only the complete structure can be interconnected.

Requirement for interconnection

Configuring CFC charts

To interconnect the structure and its elements at the block icon, the "invisible" option must
be disabled for the parameter containing the structure or structure element. The
corresponding parameter is visible at the block icon.

If you only need to interconnect individual structure elements, the parameter containing the
corresponding structure element must be visible, but not necessarily the parameter
containing the structure itself.

The "invisible" option is enabled by default and must be disabled at specific instances for each
parameter that contains a structure or structure element.
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Appearance

Block icon in the CFC

Parameters of the STRUCT data type and their elements are displayed at the block icon similar
to other block parameters. Requirement is that the "invisible" option is disabled in the
parameter properties.

The visible parameters of structure elements are displayed with indent, even if the "invisible"
option is set for the parameter containing the structure itself.
Control flow

Structure elements are displayed in the control flow with right indent.

Invisible structures and structure elements at the block

In CFC, the triangular icons below the block icon are normally used to indicate whether this
block contains hidden parameters, or hidden interconnected parameters.

For parameters of the STRUCT data type, the triangular icons are only used to indicate the
hidden, interconnected structures and structure elements, as structures and structure
elements are normally hidden in CFC.

Interconnection options
¢ Input parameter "Input” or "InOut" with the STRUCT data type:

The parameter can either be interconnected as a complete structure or the individual
structure elements of this input parameter can be interconnected individually.

¢ Output parameter "Output" with the STRUCT data type:
The complete structure, as well as individual structure elements, can be interconnected.

¢ Individual structure elements of input or output parameters of the STRUCT data type can
be interconnected to a different, compatible input or output parameter.

See also

Interconnecting the input and output parameters with an external tag (Page|146)
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45.5 Changing the color of interconnection lines

Line color and data type

The interconnection lines in the "Data flow" view of the CFC are displayed in different colors
depending on the data type.

The assignment of the data type and color can be changed.
The data type of the data source determines the shown color.
For interconnections of operands whose data type is not defined, the default value is "black".

Changing the color assignment has an effect on the display of interconnection lines in an

open CFC.
Procedure
1. Select the "Settings" command in the "Options" menu.
2. Select the "Charts > CFC > General" group in the area navigation.
3. Select the desired colors for the data types in the "Color of interconnection lines" area.
You can also use the "Default values" button to reset all settings to the default values.
Result

The color setting for the interconnection lines has been changed.
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4.5.6 Interconnecting input and output parameters

Overview
You always interconnect an output parameter with an input parameter.

When you click on an instruction or block while creating an interconnection, the possible
destination points are shown in color.

The following rules apply to interconnecting input and output parameters:

* You can only interconnect an input parameter once.

* You can interconnect an output parameter more than once.

* An interconnection is only possible if the data types of the input and output parameters
are compatible.

Possible procedures

You can create interconnections using the following methods:

* Double-click | Click

* Drag-and-drop

* Click Clack

* <C> key and click

e Copy&Paste

* Manual input of the interconnection target (Textual interconnection)

Requirement
* All CFC charts are open whose parameters you want to interconnect.

* "Data flow" is displayed.

Instructions/blocks have been inserted.

Configuring CFC charts
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Procedure

4.5 Configuration and interconnection of input and output parameters

. Double-click on the required output parameter.

An interconnection line is shown between the output parameter and the mouse pointer.

. If the interconnection destination is in the same chart, click on the input parameter at the

target object that you want to interconnect.

When you move the mouse over the input parameters, the interconnectable parameters
are displayed with a green background.

The selected parameter is displayed with a light green background.
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The interconnection is inserted and the interconnection line displayed.

. If the interconnection destination is located in another CFC chart, move the mouse pointer

onto the respective CFC chart in the taskbar after step 1.

The CFC chart is displayed in the work area.

. In this CFC chart, click on the input parameter at the target object that you want to

interconnect.
The interconnection is inserted and the interconnection line displayed.

Depending on the space available in the CFC chart, the interconnection is displayed either
fully or by connectors.

. To cancel the interconnection, click on a free location in the CFC chart or press <Esc>.

Alternative procedure: Drag-and-drop

Configuring CFC charts

1. Select the input or output parameter and keep the mouse button pressed.

2. Drag the interconnection line to the desired parameter and release the mouse button.

Drag-and-drop between charts

1. Open the CFC chart and the target chart in the data flow.

2. Todisplay both charts, click one of the buttons for splitting the editor area: — ||
3. Drag the cross-chart interconnection with the mouse button.

As an alternative, drag the parameter to the target chart using the taskbar of the open charts.
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Alternative procedure: Click Clack
1. Select the interconnection line at the input or output parameter.
The selected parameter turns magenta.
2. Select a parameter that is shown in green when you place the mouse cursor over it.

3. To create multiple interconnections, click on additional parameters displayed in green while
pressing the <Ctrl> key.

The interconnections for the clicked parameters are created.

Alternative procedure: <C> and click
1. Select the input or output parameter and press the <C> key.
The selected parameter turns magenta.
2. Click on a parameter that is displayed in green.

3. To create multiple interconnections, click on additional parameters displayed in green while
pressing the <Ctrl> key.

The interconnections for the clicked parameters are created.

Alternative procedure: Copy&Paste

Keyboard
1. Select the output parameter and press <Ctrl+C>.
2. Select the output parameter and press <Ctrl+V>.

Use the arrow keys to switch between the parameters of a block or between blocks.

Mouse operation
1. Select the "Copy" entry in the shortcut menu of the output parameter.

2. Select the "Paste" entry in the shortcut menu of the input parameter.

Configuring CFC charts
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Alternative procedure: Manual input

Enter parameter manually
Interconnection possibilities:
¢ Direct entry of the parameter in the input field
You are supported by the auto-complete function in this process.
¢ Opening a selection dialog with the triangle symbol to the right of the input field
Syntax for manual input:
* Interconnection destination is in the other CFC chart:
"\<«Chart name>\<Object name>.<Parameter name>"
Example: \Chart_1\AND_1.0UT2
* Interconnection destination is in the same CFC chart:
"<Object name>.<Parameter name>"

Example: AND_1.0UT2

Enter operand manually
Interconnection possibilities:
e Direct entry of the operand in the input field
You are supported by the auto-complete function in this process.
Syntax for manual input:
* Interconnection destination is an external tag.
"<Tag name>"
Example: "StartMotor"
* Interconnection target is a data block:
"<DB name>.<Parameter name>"

Example: "MotorDB.Start"

Procedure

1. Select the parameter to be interconnected at the block in "Data flow" or the corresponding
cell in "Control flow".

2. To create an interconnection to an address:
— Select "Interconnection to operand..." from the shortcut menu.
— Enter the interconnection destination manually or use the selection dialog box.

3. To create an interconnection to a parameter select the command "Textual interconnection
to chart..." from the shortcut menu.

— Enter the interconnection destination manually or use the selection dialog box.

Additional information: "Creating, editing and closing textual interconnections (Page 161)"
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Result

See also

140

The parameters of the two instructions/blocks are interconnected with each other.

Depending on the space available in the CFC chart, the interconnection is displayed either
fully or by connectors.

To display an overview of the points of use of interconnected tags and global data blocks, use
the "Tag interconnections" tab of the "Chart sequence & extras" editor.

Displaying points of use of interconnections (Page|153)
Representation and properties of interconnections (Page|127)
Working with multiple interconnections (Page|141)

Deleting an interconnection (Page|157)
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4.5.7 Working with multiple interconnections

Overview

You can interconnect an output parameter with several input parameters.

Place instructions or blocks with multiple interconnections in the CFC chart so that few
interconnection nodes are necessary.

The following figure shows the same interconnection, the only difference being the
positioning of the objects:
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Creating multiple interconnections

You create multiple interconnections by connecting the output parameter to the input
parameters of the target objects.

Depending on the positions of the target objects, this step results in one or more
interconnection nodes.

You have the following options to interconnect an output parameter with several input
parameters:

Procedure: <C> key and click

1. Click on the output parameter.

2. Press the <C> key.

3. Press and hold down the <Ctrl> key and click on the input parameters one after the other.

Alternative procedure: Click Clack
1. Select the interconnection line at the input or output parameter.
The selected parameter turns magenta.
2. Select a parameter that is shown in green when you place the mouse cursor over it.

3. Press and hold down the <Ctrl> key and click on other parameters displayed in green.

Alternative procedure: Copy&Paste

1. Click on the output parameter.

2. Press the shortcut <Ctrl+C>.

3. Click on the input parameters, one after the other, and press <Ctrl+V>.

Instead of the keyboard shortcuts, you can also use the "Copy" and "Paste" entries in the
shortcut menu of the parameters.

Alternative procedure: Drag-and-drop, double-click

With this procedure you need to return to the output parameter for each interconnection.
1. Create an interconnection from the output parameter to the input parameter.

2. Select the output parameter again and create the next interconnections, one after the other.
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Editing multiple interconnections
If you point to an interconnection with the mouse, editing areas are marked.

The following figure shows the editing areas with two multiple interconnections:

@ Interconnection at the input parameter.
Drag-and-drop: Interconnection with another input parameter.

Signal tracking: If you click on an editing area at the input parameter, the interconnection is
highlighted in color.

(@ Represents the interconnection at the output parameter of the source block.

Drag-and-drop: Interconnection with another output parameter. The interconnection then no
longer belongs to the multiple interconnection.

(® Represents some of the interconnections at the output parameter of the source block.
If several interconnection nodes result, these are arranged hierarchically.
Drag-and-drop: Interconnecting the input parameters with another output parameter.

® Represents all interconnections at the output parameter of the source block.
Drag-and-drop: Interconnecting all input parameters with another output parameter.

See also
Representation and properties of interconnections (Page|127)
Interconnecting input and output parameters (Page| 136)

Displaying points of use of interconnections (Page| 153)
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4.5.8 Interconnections to parameters of the chart interface

Overview

Interconnection

144

Hierarchical CFCs and standard CFCs have an interface.

This means that these CFCs can be configured and interconnected externally similar to
blocks.

Interconnections of interface parameters with blocks within the CFC are displayed in the
sheet bar of the chart with connectors.
Parameters and data types

New parameters can be added, modified or deleted in the Input, Output, InOut sections of
the chart interface.

All CFC data types are supported in the chart interface except:
* TIMER
* COUNTER

More information: "Adding, editing and sorting parameters of the chart interface (Page 92)"

Note
S7 target system: Interconnection of structure elements

The S7 target system does not support interconnections of individual structure elements of
parameters of the STRUCT data type in the chart interface.

You can only interconnect the complete structure.
S7 target system: No hardware data types

Chart interfaces do not support any hardware data types.

between interface and block parameters

You create a new interconnection between the input or output parameters of a block and an
existing parameter in the chart interface.

Drag the required block parameter with the mouse to the desired location in the chart
interface, for example, to the "Output” section for an output parameter of a block.

When you release the mouse button, the new interconnection is created and displayed in the
sheet bar of the chart with connectors when the data type matches.
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Interconnection with the creation of a new interface parameter
You can also create a new interconnection when the interface parameter does not exist yet.

Drag the required block parameter to an empty line of the matching section of the chart
interface, for example, to the "Input” section for an input parameter of a block.

When you release the mouse button, the new interface parameter with the matching data
type is created. The attributes of the associated block parameter are applied.

Rewire interconnection: Blocks

In a rewire you change an existing interconnection between the input and output parameters
of blocks in the chart interface.

Drag the required interconnection at the block parameter to an existing parameter in the
chart interface using drag-and-drop.

The mouse pointer indicates if this interconnection is possible.

When you release the mouse button, the selected interconnection is rewired to the required
parameter in the chart interface.

Rewire interconnection: Interface and block parameters

You can also rewire an interconnection between a block parameter and an interface
parameter to an existing interface parameter.

Drag the connector of this interconnection in the chart sheet bar, for example, "Input2" to an
existing parameter of the chart interface, for example, "Input7".

The mouse pointer indicates if this interconnection is possible.

When you release the mouse button, the selected interconnection is rewired to the required
parameter in the chart interface. The associated connector in the sheet bar is renamed, for
example, to "Input7".

As long as an interface parameter has not been interconnected, the table cell of the "Data
type" column has a "light gray" background color.

Upon interconnection, the background color changes to "medium gray".

See also
Hierarchical CFC charts (Page 31)
Interconnecting input and output parameters (Page| 136)

Displaying points of use of interconnections (Page|153)
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4.5.9 Interconnecting the input and output parameters with an external tag

Overview

If you need values from the device in the CFC, or want to return values to the PLC,
interconnect an input and output parameter with an external tag.

Depending on the target system you are using, an external tag represents signals from
modules or the device.

An external tag can also be a structure.

Note
Interconnection only possible in the target system

You can only use external tags that belong to the same controller as the CFC.
Synchronization while compiling the chart

Only the name of the external tag is stored in the connector.

Whether or not a tag with this name exists in the target system is only checked when the
chart is compiled.

Interconnecting structures
You can interconnect structures with input and output parameters of the STRUCT data type.

You can interconnect the complete structure, as well as individual structure elements with
the compatible block parameters.

Additional information: "Interconnections with structures as input and output parameters
(Page 133)"

Requirement
e ACFCisopen.
* The detail window is displayed.
* "Data flow" is displayed.
* Instructions/blocks have been inserted.

* The data types of the external tag and the input or output parameters are compatible.

Procedure
1. Select the folder in the project tree in which the external tags are stored.
The position of the folder depends on the target system you are using.

2. Drag the external tag from the detail window to the input or output parameter.
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Alternative procedure

As an alternative, you can also interconnect the external tag using the shortcut menu of the
input or output parameter.

If you have created a tag for a signal, you can drag a signal of a module to an input or output
parameter directly from the device configuration.

Result
The input or output parameter is interconnected to the external tag.
The connector with the tag name is positioned either in the sheet bar or besides the
parameter depending on the sheet bar view you have set.

See also

Setting the parameters of the input and output parameters (Page|123)
Copying instructions, blocks and charts (Page|107)

Interconnecting input and output parameters (Page|136)
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4.5.10

Overview

Adding or removing input parameters

When you insert an instruction to a CFC chart, this object already comes with a certain
number of input parameters by default.

You have the option to change the number of input parameters with generic instructions.

There are generic instructions in CFC in the "Instructions" task card in the following
instruction families:

* BIT_LGC: Bit logic operations

e MATH_FP, MATH_INT: MathFloat (arithmetic instructions)

e MULTIPLX: Multiplexer

* WRD_LGC: Word logic operations

¢ Additional instructions: TERMINAL (compilation of interconnections)

When an instruction can be extended, the following symbol is displayed at the bottom of the
instruction icon: ¢

The symbol is hidden once the maximum number of possible input parameters has been
reached.

Changing the number of parameters

148

You can change the number of input parameters using the following options:
* Adding or removing input parameters:

You can make both changes in the properties of the Inspector window.
* Adding input parameters:

To add an input parameter to the instruction, click on the icon at the instruction symbol: ¢

Note
Reducing the number

The value cannot be lower than the number of interconnected input parameters, because
only non-interconnected input parameters can be deleted.

If several parameters are not interconnected, the highest index number of the interconnected
parameters determines the value. If the 1st and the 5th of 10 parameters are interconnected,
the lowest value corresponds to the index of the 5th parameter.
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Example

>

LYE

The figure shows an "OR" instruction with two input parameters that are not interconnected.

The following icons are displayed at the bottom of the instruction symbol:

Icon

Meaning

The number of input parameters can be increased.

A

At least one input or output parameter is invisible.

Requirement

Procedure

Result

Configuring CFC charts

A CFC chart is open.

An expandable instruction has been added.

. Select the required instruction in the CFC chart.

. In the Inspector window, select the "Properties” tab and then the "General" tab.

The current number of inputs are displayed in the "Number of input parameters" field.

. If you want to add an input parameter, simply increase the value in the "Number of input

parameters" field.

You can also add an input parameter by clicking the icon in the CFC chart below the
instruction symbol.

. If you want to delete an input parameter, simply decrease the value in the field "Number of

input parameters".

One or several input parameters have been added or removed.

You can see an overview and the status of all input and output parameters in the Inspector
window in the "Properties" tab under "Parameters".
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4.5.11 Negating input parameters

Requirement
* The input parameter is interconnected.

e The input parameter has the BOOL data type.

Procedure
1. Select the interconnection of the input parameter.
2. Select the "Negate" option in the shortcut menu of the interconnection.

Alternatively, select the option in the properties of the interconnection in the inspector
window.

Result
The negation symbol is shown at the input parameter.
The value at the input parameter is negated.
If you move or copy the negated interconnection, the negation is retained.
The following figure shows a negated interconnection:

> I

See also
Representation and properties of interconnections (Page|127)

Setting the parameters of the input and output parameters (Page 123)
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4.5.12 Hiding input and output parameters

The space available for objects, such as instructions, blocks and interconnections, in a CFC
chart is limited by the sheet size.

To gain more space for displaying objects on a sheet, you can hide the input or output
parameters. This makes the CFC chart clearer to read.

Manage hidden parameters

To display the overview and the status of all parameters, select the instance in the chart and
click on "Properties > Interface" in the Inspector window.

If the hidden parameter is interconnected, it is also listed under "Invisible interconnections”.

To edit the interconnection of a hidden parameter, make the interconnection listed in
"Invisible interconnections” visible again. As a result, the interconnected parameter is visible
again.

Display at the icon

Hidden parameters of an instruction or block are identified at the associated icon separated
by input and output parameters:

i One or more interconnected parameters are hidden.
A One or more non-interconnected parameters are hidden.

Display at the partner block

The interconnection to a hidden parameter is displayed at the partner block depending on the

settings:
Sheet bar mode Display
Static sheet bar In the sheet bar
Dynamic sheet bar In the sheet bar
No sheet bar As connector

Requirement
¢ A CFCchartis open.

¢ An instruction or block has been added.

Procedure
1. Select the input or output parameter.

2. Select the "Invisible" option under "General" in the Inspector window.
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Result

The input or output parameter has been hidden.

See also

Representation and properties of interconnections (Page|127)
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45.13 Displaying points of use of interconnections

Overview

In the "Chart sequence & extras" editor, all interconnections are displayed in the "Tag
interconnections" tab.

The list of tag interconnections supports you in searching for interconnected tags and
interconnected global data blocks in the CFC charts:

¢ You can filter the list by different criteria.

* You jump from the tag line in the table directly to the reference location in the CFC chart.

¢ The list is comparable to the cross-reference list.

However, unlike in the cross-reference list, you cannot add new entries.

CFC tag interconnections

The table contains the following information:

Column

Content

Tag name

Name of the interconnected tag:
* Tags
* Global data blocks

Address

Address of the interconnected tag

Data type

Data type of the interconnected tag

Read/write

Identification of the access:

e Read access:

Interconnection of output parameters ("Output”)
e Write access:

Interconnection of input parameters ("Input”, "InOut")

Path

Path of the interconnection:
e Chart name
¢ Block instance name

e Parameters
The path is linked with the interconnected parameter.
When clicking on the path, the view jumps to the reference location in the data flow.

Comment

Comment for the tag
Comments of the CFC charts, instances and parameters are not included.

Block type

Type of the interconnected block

Configuring CFC charts
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Requi